NXP Semiconductors Document identifier: CM33GFLIBUG
User Guide Rev. 5, 01 November 2021

GFLIB User's Guide

ARM® Cortex® M33




NXP Semiconductors

Contents
Chapter 1 LIDrary.......cccoo s s e e e annn e e e e e e e 5
I 1 (o Yo T 1 o T 5
I O 17T V=2 5
(R B B - £ I 1Y L= TP PRRPTTPRPT 5
(IR I S o o= 0114 o T 5
(I ST W o] o o]y (=To leTo] 0 ] 11 =T = T PRSP 6
1.1.5 Library CONfIQUIAtION..........ueiiiii ettt e et e e e e e s enneeeee s 6
1.1.6 SPECIAI ISSUES. ....eeiiiiieiiie ettt e et e e e e bt e e e e et e e e e e b b e e e e e e nbreeeeeannreas 6
1.2 Library integration into project (MCUXPresso IDE) ........cccoiiiiiiiiiiiiiee e 6
1.3 Library integration into project (Keil HVISION) ......cooiiiiiiiiiiiiee e 10
1.4 Library integration into project (IAR Embedded Workbench) .............ccccccoiiiiiiiiiiiie 18
Chapter 2 Algorithms in detall...........cooooriimceii e 24
b B €T o I 1= TS [ o T TP 24
Dt B B AN VZ= 1 F= o L IRV Z=T 1 o] o 24
R I B L= o F= T = (o] 1N 25
D IR B LU o T [ o TV T < 25
A € o I 1 = T O o 1T 25
R W AN VZ= 1 F= o (IR Z=T 51 o] o T 25
A B = o F= T = (o] 1N 26
R B LU o [ox 1[0 o TV T < 26
R €1 I 1 = T =T o DT TR 26
P B B AN VZ= 11 F= o LIV Z=T 1 o] o 27
R I B 1= Tor F= T = (o] o 1N 27
PR IR I LU o [ox 1[0 o TV T < 27
A 1 I 1= T X3 1 TR 28
oy W ANV Z= 11 F= o LIV Z=T 1 o] o 28
N B 1= o F= T = (o] o 1N 28
G B LU o [ox [0 o TV T < 28
R Y € 1= T Yoo =TT 29
P T B AN VZ= 1= o (IR Z=T 51 o] o 29
A B L= o F= T = (o] 1N 30
IR I LU o [ox 1[0 o TV T < 30
2.8 GFLIB A AN, ... e e e ———— 30
P T B AN VZ= 1= o (IR Z=T 1 o] o 31
I B L= Tor F= T = (o] 1N 31
B2 I I LU o [ox [0 o TV T < 31
2.7 GFLIB A ANY X e e 32
N A W V7= 1= o (IR Z=T 51 o] o 33
A B = Tor F= T = (o] 1N 33
R I oLV o [ox 1T o TV T < 33
P T o 1= TS T | PP 34
P < B W AN VZ= 1= o (IR Z=T 1 o] o 34
R S A B = Tor F= T = (o o 1R N 34
P S IR I LU o [ox 1T o TV T < 34
e €1 o I 1= T T o1 SRR 35
P B B AN VZ= 1= o LIV Z=T 1 o] o 35
S I B = Tor F= T = (o] 1N 35
2 IR I LU o [ox 1T o TV T < 35
2.10 GFLIB _LOWEILIMIL. ...t e et e e et e e e e e e e e e e e e e e e e areeeenaas 36

GFLIB User's Guide, Rev. 5, 01 November 2021
User Guide 2/106




NXP Semiconductors

Contents

O B B N V= 1 =T o] (ST ] o 1= 36

D L0 T2 1Yol =T = (o o TR 36

D L IR T U] o T 1[0 o U == T 37

211 GFLIB_UPPEILIMIL. ...ttt e e e e e e e e e e e e e s nnneeeees 37
Dt T B B N V= 1 = o] (ST T ] o 1= 37

Dt T B 1Yol =T = (o o TR N 37

b T B B U T 1[0 o U <= T 38

2.12 GFLIB _VECIOILIMIL. ... et e e e e et e e e e e e e e e e e e e e eean 38
D I B V= 11 = o] (ST ] o) 1= U 39
2.12.2 GFLIB_VECTORLIMIT_T_F16 type desCription.........ccceiiiiiiiiiiiiiieeee e e e 39

D T B 1Yol =T = (o o TR N 39

e A U] o T 1[0 o U 1= T 39

A RO € o I 1 = VA=Y ex (o5 N[0 1 TP 40
2 I T B N V= 11 = o] (ST ] o 1= 41
2.13.2 GFLIB_VECTORLIMIT_T_F16 type desCription.........cccoiiiiiiiiiiieiieeee e e e 41

D B TG T B 1Yol =T =1 (o TR N 41

R BN U] o T 1[0 o U == T 42

D B = T Y S 42
U B N V= 11 = o] (ST ] o 1= 42

o N e e | o DS N I 1 TR 43

D T B 1Yol =T = (o o TR N 43
D U] o T [0 g U =T T 43

A RS € = I 1= U & 1 TR 44
T B N V= 11 = o] (ST ] o) 1= 44
R E T B 1Yol =T = (o o TR N 45
R E TG T U] o T 1[0 o U 1= T 45

A Kol € o I 1= U { =Y o I T ST 46
I T B N V= 11 = o] (ST ] o) 1= 46

D LI B 1Yol =T = (o o TR N 47

D LT B U] o T (o] o U == T 47

D a1 | ST <= T o] o TP 48
2 I A B V= 11 = o] (ST ] o 1= 48
2.17.2 GFLIB_RAMP _T _F 1B ittt ettt ettt e e s e e e e e e e aeeeaaeaeneeeeereeeeerenes 49
2.17.3 GFLIB_RAMP T 32 .ottt et et ettt e e s e e e e e eeaeaeaaeaeaeeeeereeeeeranes 49

R A 1Yol =T = (o o TR N 50

D A ST VT o T 1[0 o U 1= T 50

2.18 GFLIB_DRAMP ...ttt ettt et e eeeeeeeeeeeaees e eeeeee e e eeeeeeeeeeeseeseeesseeseesseeeeeeeeeeeeeneeeeeeees 50
Pk < T B V= 11 = o] (ST ] o 1= 51
2.18.2 GFLIB_DRAMP L _T _F 1B, ..ottt e e e e e e e e e e e e et e ettt e e e e e e eeeeeeas 52
2.18.3 GFLIB_ D RAMP T 3. . it e e e e e e e e e e et e ettt e e e e e e e e eeaeas 53
T B 1Yol =T = (o TR N 53
< T T U] o T 1[0 o U == T 53

2.19 GFLIB_FIEXRAMP. ... 54
P B B N V= 11 =T o] (ST ] o) o 1= 55
2.19.2 GFLIB_FLEXRAMP _T _F 32ttt e e e e e e e e e e e e e e e e e e e e eeeeereeeeerenes 56

D LS IR T B 1Yol =T =1 (o o TR N 56
e I U] o T (o] o U == T 57

2.20 GFLIB_DFIEXRAMIP. ... i saaaaaasesastsasesssesssesnsssnssnnnsnnnnnnnes 58
O B B V= 11 = o] (ST ] o 1= 59
2.20.2 GFLIB_DFLEXRAMP _T _F32. ..ot e e e ettt e e e e e e e eeeeas 60

B T B 1Yol =T =1 (o TR N 61
O I U] o T (o] o U =T T 61

2.21 GFLIB_FIEXSRAMP...cc i 62
o W B V= 11 = o] (ST ] o 1= 67
2.21.2 GFLIB_FLEXSRAMP T _F B2, .ttt e e e e e e e e e e e e e e e e e e e e aeranes 68

GFLIB User's Guide, Rev. 5, 01 November 2021
User Guide 3/106




NXP Semiconductors

Contents

D BT B 1Yol =T = (o o TR N 69

g W U] o T (o] o U =T T 69

2.22 GFLIB_INtEQrator... ..o 70
A B V7= 11 = o] (ST ] o o 1= 72
2.22.2 GFLIB_INTEGRATOR LT A2, . oo e e e e e e e e e e e e e e e e e e e e eaeaeaanes 72
A T B 1Yol =T = (o TR N 72
A N U] T[0T U == T 73

2.23 GFLIB_CHrIBetalPPAW.......coeeeeeeeeeeeeeeeeeee ettt et e e e e e e e e e e e e e eeeeeeeeeeeeeeeeeeeeeeeeeeeeees 73
o T B V= 11 = o] (ST ZoT ] o 1= 75
2.23.2 GFLIB_CTRL_BETA_IP_P_ AW T A2 . oo e e e e e e e e e e e eeaeaanes 76
B T T B 1Yol =T =1 (o o TR N 77
A B N U] o T 1[0 o U == T 77

2.24 GFLIB_CtrIBetalPDPAW. ... 78
o B V= 11 = o] (ST ] o) 1= T 81
2.24.2 GFLIB_CTRL_BETA_IPD_P_AW T A3 2. . it e e e e e e e e e e e e eeeaaaes 81
R B 1Yol =T = (o TR N 82
N U] o Lo (o] U 1= T 82

2.25 GFLIB_CHIPIPAW. ..., 83
T B V7= 11 = o] (ST ZCT ] o 1= 85
2.25.2 GFLIB_CTRL_PI_P _ AW T A3 . ettt ettt e e e e e e e e e eeees 86
A T T B 1Yol =T = (o TR N 86
AN N U] o T (o] U 1= T 86

2.26 GFLIB_CHIPIDPAWV. ... . 87
T B V= 11 = o] (ST ] o 1= 90
2.26.2 GFLIB_CTRL_PID _ P _ AW T A 2. it e e e e e e e e e aans a0
IR B 1Yol =T =1 (o TR N 91
R N U] o T (o] U == T 91
Appendix A Library fypes. ... et e nnas 93
N I o Yo Yo I PR T 93
F N U1 € T T 93
F N U0 o T 94
YN R U1 o 52 ST 95
F ST 101 < TN ST 95
F ST 101 T T 96
F A 101 7 T 96
YN I i = (o< T T 97
YN I i = (o T P 98
Y (O = To2C 2 T 98
Y I = Voo T T 99
Y A= Vol o 1 ST 100
F N S (o Y=Y A ST 100
F N I o RS Y T 103
F N T I L 1 T 103
Y L TN O S T 104
F N A 7 N Ot 1 TR 104
YN R YN O TR 104
F N LS N O Ot 1 T 105
YN O O O T 105

GFLIB User's Guide, Rev. 5, 01 November 2021
User Guide 4/106




NXP Semiconductors

Chapter 1
Library

1.1 Introduction

1.1.1 Overview

This user's guide describes the General Functions Library (GFLIB) for the family of ARM Cortex M33 core-based microcontrollers.
This library contains optimized functions.

1.1.2 Data types

GFLIB supports several data types: (un)signed integer, fractional , and accumulator. The integer data types are useful for
general-purpose computation; they are familiar to the MPU and MCU programmers. The fractional data types enable powerful
numeric and digital-signal-processing algorithms to be implemented. The accumulator data type is a combination of both; that
means it has the integer and fractional portions.

The following list shows the integer types defined in the libraries:

* Unsigned 16-bit integer—<0 ; 65535> with the minimum resolution of 1

» Signed 16-bit integer—<-32768 ; 32767> with the minimum resolution of 1

* Unsigned 32-bit integer—<0 ; 4294967295> with the minimum resolution of 1

» Signed 32-bit integer—<-2147483648 ; 2147483647> with the minimum resolution of 1
The following list shows the fractional types defined in the libraries:

+ Fixed-point 16-bit fractional—<-1 ; 1 - 2-15> with the minimum resolution of 2-15

+ Fixed-point 32-bit fractional—<-1 : 1 - 231> with the minimum resolution of 2-31
The following list shows the accumulator types defined in the libraries:

+ Fixed-point 16-bit accumulator—<-256.0 ; 256.0 - 27> with the minimum resolution of 27

« Fixed-point 32-bit accumulator—<-65536.0 ; 65536.0 - 2-15> with the minimum resolution of 2-15

1.1.3 API definition

GFLIB uses the types mentioned in the previous section. To enable simple usage of the algorithms, their names use set prefixes
and postfixes to distinguish the functions' versions. See the following example:

f32Result = MLIB Mac F321ss(f32Accum, flé6Multl, fl6Mult2);

where the function is compiled from four parts:
* MLIB—this is the library prefix
* Mac—the function name—Multiply-Accumulate
* F32—the function output type

» Iss—the types of the function inputs; if all the inputs have the same type as the output, the inputs are
not marked

The input and output types are described in the following table:
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Table 1. Input/output types

Type Output Input
frac16_t F16 ]
frac32_t F32 I
acc32_t A32 a

1.1.4 Supported compilers

GFLIB for the ARM Cortex M33 core is written in C language or assembly language with C-callable interface depending on the
specific function. The library is built and tested using the following compilers:

* MCUXpresso IDE
* IAR Embedded Workbench
» Keil pyVision
For the MCUXpresso IDE, the library is delivered in the gfiib.afile.
For the Kinetis Design Studio, the library is delivered in the gflib.afile.
For the IAR Embedded Workbench, the library is delivered in the gfiib.a file.
For the Keil pVision, the library is delivered in the gfiib./ib file.

The interfaces to the algorithms included in this library are combined into a single public interface include file, gfiib.h. This is done
to lower the number of files required to be included in your application.

1.1.5 Library configuration

GFLIB for the ARM Cortex M33 core is written in C language or assembly language with C-callable interface depending on the
specific function. Some functions from this library are inline type, which are compiled together with project using this library. The
optimization level for inline function is usually defined by the specific compiler setting. It can cause an issue especially when high
optimization level is set. Therefore the optimization level for all inline assembly written functions is defined by compiler pragmas
using macros. The configuration header file RTCESL_cfg.his located in: specific library folderIMLIBlInclude. The optimization
level can be changed by modifying the macro value for specific compiler. In case of any change the library functionality is

not guaranteed.

Similarly as optimization level the PowerQuad DSP Coprocessor and Accelerator support can be disable or enable if it has
not been done by defined symbol RTCESL_PQ_ON or RTCESL_PQ_OFF in project setting described in the PowerQuad DSP
Coprocessor and Accelerator support cheaper for specific compiler.

1.1.6 Special issues

1. The equations describing the algorithms are symbolic. If there is positive 1, the number is the closest number to 1 that
the resolution of the used fractional type allows. If there are maximum or minimum values mentioned, check the range
allowed by the type of the particular function version.

2. The library functions that round the result (the API contains Rnd) round to nearest (half up).

3. This RTCESL requires the DSP extension for some saturation functions. If the core does not support the DSP extension
feature the assembler code of the RTCESL will not be buildable. For example the core1 of the LPC55s69 has no DSP
extension.

1.2 Library integration into project (MCUXpresso IDE)

This section provides a step-by-step guide on how to quickly and easily include GFLIB into any MCUXpresso SDK example or
new SDK project using MCUXpresso IDE. The SDK based project uses RTCESL from SDK package.

GFLIB User's Guide, Rev. 5, 01 November 2021
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PowerQuad DSP Coprocessor and Accelerator support

Some LPC platforms (LPC55S6x) contain a hardware accelerator dedicated to common calculations in DSP applications. This
section shows how to turn the PowerQuad (PQ) support for a function on and off.

1. Inthe MCUXpresso SDK project name node or in the left-hand part, click Properties or select Project > Properties from the
menu. A project properties dialog appears.

2. Expand the C/C++ Build node and select Settings. See Figure 1.
3. On the right-hand side, under the MCU C Compiler node, click the Preprocessor node. See Figure 1.

-
[ Properties for twrkv31f120m_demo_apps_hello_world

e, i)

type filter text Settings G- .
» Resource
Builders =
4 C/Ce+ Build Configuration: Debug [ Active ] N
Build Variables
Environment
Logging 5 Tool Settings | Build steps | ' Build Artifact | [ Binary Parsers | @ Ermor Parsers |
MCU settings
Settings 4 5 MCU C Compiler [71Do not search system directories (-nostdinc)
Toal Chain Editor (5 Dialect [ Preprocess only (-E}
» C/C++ General (5 Preprocessor — -
Project References (5 Includes Defined symbols (-0) a8 8ilH |
RanDebug Setings 5 Opimesien
(& Debugging DEBUG

PRINTF_FLOAT ENABLE=0
SCANF_FLOAT_ENABLE=0
PRINTF_ADVANCED_ENABLE=0
(B Architecture SCANF_ADVANCED_ENABLE=0
4 55 MCU Assembler TWR_KV31F120M

& Genersl Ik DLOUGCONSOLE-0

(2 Architecture & Headers - -

(B Wamings
(2 Miscellaneous

__MCUXPRESSO
4 5 MCU Linker T USE CmsIs
2 General CPU_MKV31F512vLL12
(5 Libraries CPU_MKV31FS12VLL12 emd

(£ Miscellaneous
(% Shared Library Settings

_REDLIB_

(B Architecture Undefined symbols {-U) 0 8§l &
(# Managed Linker Script
(2 Multicore
< m *
@

Figure 1. Defined symbols

4. In the right-hand part of the dialog, click the Add... icon located next to the Defined symbols (-D) title.
5. In the dialog that appears (see Figure 2), type the following:

+ RTCESL_PQ_ON—to turn the PowerQuad support on

* RTCESL_PQ_OFF—to turn the PowerQuad support off

If neither of these two defines is defined, the hardware division and square root support is turned off by default.

Defined symbols (-D)

RTCESL_ PO ON I

Figure 2. Symbol definition

6. Click OK in the dialog.
7. Click OK in the main dialog.
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8. Ensure the PowerQuad moduel to be clocked by calling function RTCESL_PQ_lInit(); prior to the first function using PQ
module calling.

See the device reference manual to verify whether the device contains the PowerQuad DSP Coprocessor and
Accelerator support.

Adding RTCESL component to project

The MCUXpresso SDK package is necessary to add any example or new project and RTCESL component. In case the

package has not been downloaded go to mcuxpresso.nxp.com, build the final MCUXpresso SDK package for required board and
download it.

After package is dowloaded, open the MCUXpresso IDE and drag&drop the SDK package in zip format to the Installed SDK

window of the MCUXpresso IDE. After SDK package is dropped the mesage accepting window appears as can be show in
following figure.

=
File Edit Mavigate Search Project Configlools Run RTOS Analsis Window Help
N R |® -] - -0 TR R R s 2w (S| bHhE2DR
Bow: LA U-F oot Q iR
[ Project B 57 1) Registers %5 Faults &, Periphera.. = O =0
8% 7 | |- 8

There are ne projects in your werkspace.
To add a project:

B Creste s new MCUXpresso IDE C/C+ + project.
B8 Import examples from SDK.
% Create s project...

i Import projects... @) “reyou sureyou want to import the following SDK in the
&Y common 'maupresso! folder?

B MCUXpresso IDE SDK import - O X

D:ASDK_2_10_0_HVP-KV31F120M.zip

@ inst.. 2 [ Prop.. [2 Pny ]

[ Installed SDKs

(1) Quickstart Panel £ (x)= Variables ®g Breakpoints = [ Toinstallan SDK, simply drag and lpresy

, #  |Installed SDKs . Available Buard_
- MCUXpresso IDE - Quickstart Panel 1 b
e ] No t selected Name
project selecte
+ Create or import a project

p— B New project...

?a
I rt SDK le(s)...
@ impo example(s) [] Do not ask for confirmation on SDK Drag and Drop install
#® Import project(s) from file system...
~ Build your project

g {1 MCUX workspace

Figure 3. MCUXpresso IDE - imporing the SDK package to MCUXpresso IDE

Click OK to confirm the SDK package import. Find the Quickstart panel in left bottom part of the MCUXpresso IDE and click New
project... item or Import SDK example(s)... to add rtcesl component to the project.
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8 MCUX workspace - MCU¥presso IDE

File Edit Mavigate Search Project Configlools Run RTOS Analysis Window Help

Al | &~ ]~ e R H-O0-U-®Y-IRETID N
@il Ril-Fl-o e
[ Project Ex.. 5 4! Registers 45 Faults &, Periphera.. = O

28lv|i#% B8
There are no projects in your workspace.
To add a project:
B8 Create a new MCUXpresso IDE C/C++ project.
B Import examples from SDK.
9 Create a project..

i Import projects...

() Installed SDKs

@ inst. 52 [OProp.. (2 Probl.. B Cons.. @Term.. [z Ima..

- a x
[N e S hE R
Q K

= 8

@ Debu.. 2 Offfin.. = B

®o D

(1) Quickstart Panel 57 (%)= Variables 9 Breskpoints = F  Toinstall an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Installed SDKs' view. [Common 'mecuxpres:
MCUX \DE icketart Panel A [installed SDKs . Available Boards| Available Devices |
resso - Quickstart Panel
el P a Name SDK Version Manifest Version  Location
o project selected
HHSDK 2o HVP-KVITF120M | 2,10.0 380 T SOk 2100 FVB-Ky
~ Create or import a project

Invoke the new SDK project wizard

~ Build your project

@

~ SDK MCUs . Available boards

MCUs from installed SDKs. Please click

above or visit mcuxpresso.mxp.com to
obtain additional SDKs.

Please select an available board for your project.

[ Supported boards for device: MKV3TFS120012

vllx — >
Figure 4. MCUXpresso IDE - create new project or Import SDK example(s)
Then select your board, and clik Next button.
) 50K Wizard o x
(D) Cresting project for device: MKV31F5120012 using board: HVP-KV31F120M x @
. Board and/or Device selection page .

NP MKV3TF512300x12

v KV3x
MKV3TF512xxx12

hvpkv31£120m

~ Preinstalled MCUs
MCUs from preinstalled LPC and
generic Cortex-M part support
NXP PN7462AU-C3-00 "
PN7462AU-C2-00
PN7462AU-C3-00
Generic-MD
Generic-Moplus
Generic-M23
Generic-M3
Generic-M33
Generic-M4
Generie-M7

v

Selected Device: MKV31F512300¢12 using board: HVP-KV31F120M
Target Core: emd
Description:

SDKs for selected MCU
Name

Kinetis KV3x-100-120 MHz, Advanced 3ph FOC / Sensorless Motor Control MCUs

based on ARM Cortex-M4 2 SDK_2x_HVP-KVITF120M 2,100

@

SDK Version

Manifest Ve... Location

(49420; 380 JE <Common>\SDK_2_10_0_HVP-KV:

< Back Finish Cancel

Figure 5. MCUXpresso IDE - selecting the board

Find the Middleware tab in the Components part of the window and click on the checkbox to be the rtcesl component ticked. Last

step is to click the Finish button and wait for project creating with all RTCESL libraries and include paths.
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Figure 6. MCUXpresso IDE - selecting rtcesl component

Library
3 soK Wizard u] X
i, The source from the SDK will be copied into the workspace. If you want to use linked files, please unzip the 'SDK_2x_HVP-KV31F120M' SDK. VA &
. Configure the project
Project neme: | MKV31F31212_FirstProject] * | Project name suffix:

Use default location

C:\MCUX_workspace\MKV31F51212_FirstProject Browse..
Device Packages Board Project Type Project Options
® MKV3IFS12VLLIZ ® Defaut board files @CProject (O Cr+ Project SDK Debug Console (3 Semihost @) UART
O MKV31F312VLH12 O Empty board files [ CMSIS-Core

(O C Static Library () C++ Static Library Copy sources

[ Import other files

Components [F] Components selection summary B
Add or remove SDK software companents [ipesotiter |
Operating Systems [Drivers [CMSIS Drivers [ Utilities [Widdieware™ Board Components| Abstraction Layer| Software C =
Name Description Ve Info
Middleware B %l ®E £ Drivers
[opesotiter | £ Middlenere
£ Operating Systems
Name Description Version  Info = Software Component
[ £ FresMASTER £ Utilties
[ £ Memories.
[1 = Motor Cantrol
T rice! Real Time Control Embedded Software Library for CM... 110 | Real Time Gontrol Embedded Software Library far CNUF core
@ <Back Next> T

Type the #include syntax into the code where you want to call the library functions. In the left-hand dialog, open the required .c
file. After the file opens, include the following lines into the #include section:

#include "mlib.h"
#include "gflib.h"

When you click the Build icon (hammer), the project is compiled without errors.

1.3

Library integration into project (Keil pVision)

This section provides a step-by-step guide on how to quickly and easily include GFLIB into an empty project or any
MCUXpresso SDK example or demo application projects using Keil pVision. This example uses the default installation path
(C:ANXP\RTCESL\CM33_RTCESL_4.7_KEIL). If you have a different installation path, use that path instead. If any MCUXpresso

SDK project is intended to use (for example hello_world project) go to Linking the files into the project chapter otherwise read
next chapter.

NXP pack installation for new project (without MCUXpresso SDK)

This example uses the NXP LPC55s69 part, and the default installation path (C:\NXP\RTCESL\CM33_RTCESL_4.7_KEIL) is
supposed. If the compiler has never been used to create any NXP MCU-based projects before, check whether the NXP MCU pack
for the particular device is installed. Follow these steps:

1.

Launch Keil pVision.

. In the main menu, go to Project > Manage > Pack Installer....

. In the left-hand dialog (under the Devices tab), expand the All Devices > Freescale (NXP) node.

2
3
4.
5

Look for a line called "KVxx Series" and click it.

. In the right-hand dialog (under the Packs tab), expand the Device Specific node.

GFLIB User's Guide, Rev. 5, 01 November 2021
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6. Look for a node called "Keil::Kinetis_KVxx_DFP." If there are the Install or Update options, click the button to install/
update the package. See Figure 7.

7. When installed, the button has the "Up to date" title. Now close the Pack Installer.

18 Pack Installer - CKeil vS\VARMIPACK — - B =El =]
File Packs Window Help
[+l ‘ Device: Freescale - KVaox Series
4 Devices | Boards | T Packs | Examples | i
‘ Search: - X Pack Action Description
Device A =1~ Device Specific 1 Pack
I @ Atmel 257 Devices ||| | KeiKinetis Ko DFP | Tnstoll Freescale Kinetis Kixx Series Device Support
@ Fresscale 234 Devices El-Generic 10 Packs
%2 K Series 1 Device RM:CMSIS & Up io daic | CMSIS (Cortex Microcontroller Software Interface Standard)
42 K00 Series 2 Devices eilzARM_Compiler | & _Up to date | Keil ARM Compiler extensions
42 K10 Series 23 Devices eil:Jansson & Install___| Jansson is a C library for encoding, decoding and manipula
42 K20 Series 41 Devices eil:MDK-Middleware | & Update | Keil MDK-ARM Professional Middleware for ARM Cortex-M
42 K0 Series & Devices - Keil:MDK-Network DS | & Install Keil MDK-ARM Professional Middleware Dual-Stack IPud,/IP
42 k40 Series & Devices B-hwiPz P & Install IwIP is 2 light-weight implementation of the TCR/IP protoc
42 K50 Series 11 Devices - Micrium:RTOS & Install Micrium software components
42 K60 Series 18 Devices -Ory Package (CycloneTCP, CycloneSSL and Cyclon
42 K70 Series 4 Devices - wolfSSL::CyaSSL Light weight SSL/TLS and Crypt Library for Embedded Syste
42 K30 Series 2 Devices 1 - YOGITECH:ARSTL_AR. YOGITECH fRSTL Functional Safety EVAL Software Pack for
% KEdoo Series 6 Devices
4 Kb Series 11 Devices
4 Ko Series 54 Devices
% KMo Series 14 Devices
4 Ko Series 26 Devices
% Ko Series 8 Devices
% WPRISI6 Series |1 Device
P e ha | K |

Output 3 x

Refresh Pack descriptions

Update available for Keil:MDK-Middleware (installed: 6.4.0, available: 7.0.0-beta}

Ready [ [onme

New project (without MCUXpresso SDK)

To start working on an application, create a new project. If the project already exists and is opened, skip to the next section. Follow

these steps to create a new project:

1. Launch Keil pVision.

2. In the main menu, select Project > New pVision Project..., and the Create New Project dialog appears.

3. Navigate to the folder where you want to create the project, for example C:\KeilProjects\MyProject01. Type the name of the

project, for example MyProject01. Click Save. See Figure 8.

Create New Project

» Computer » System (C:) » KeilProjects » MyProject0l

File name:  MyProject0l

Save as type: IPro}act Files (*.uvproj; *.uvprojx)

= Browse Folders Save

Figure 8. Create New Project dialog

In the next dialog, select the Software Packs in the very first box.

Type " into the Search box, so that the device list is reduced to the devices.
Expand the node.

Click the LPC55s69 node, and then click OK. See Figure 9.

N o o &
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- =
Select Device for Target 'Target 1°.

Device |Targe¢| Ol.rlputl Listing I User | C/CH-I Asm I Linkerl Debug I Uhl'rtiesl

ISoﬂwar\e Packs
Vendor: NXP
Device: LPC55565JBD100:cm33_corel
Toolset: ARM

=

Software Pack
Pack: INXP.LPC55SG‘3_DFP.12.11

URL:  http://meuspresso.rvp. com/cmsis_pack/frepc

Search:

@ ARM -
=@ NXP
# k32020414
03 KExx Series
=% LPC55560
=% LPCSss6o
% LPC53568/BD100
1 LPC55569)BD100
@ LPC55569)BD100

A ol

The LPCBS/L PC55S5kx is an ARM Cortex M33 basad micro-
controller for embedded applications. These devices include up to
320 KB of on-chip SRAM, up to 640 KB on-chip flash, high-speed
and full-speed USB host and device interface with crystaldess
operation for full-speed, five generalpurpose timers, one
SCTimer/PWM, one RTC/alam timer, one 24-bit Mutti-Rate Timer
(MRT), a Windowed Watchdog Timer (WWDT), eight flexible serial
communication peripherals {each of which can be a USART, SPI,
12C. or 125 interface), one 16-bit 1.0 Msamples/eec ADC, temperature
sensor.

Figure 9. Select Device dialog

8. In the next dialog, expand the Device node, and tick the box next to the Startup node. See Figure 10.

9. Expand the CMSIS node, and tick the box next to the CORE node.

Software Compenent Sel.  Variant
4 Board Support
ER-¥HH
@ CORE

| @ Dsp

@ NNLib
& RTOS (4PN
& RTOS2 (AP))
+ CEET
& Compiler ARM Compiler
= € Device

4 SDK Drivers

4 SDK Project Template

4 SDK Utilities
4 File System MDK-Plus
4 Graphics MDK-Plus
€ Network MDK-Plus

Source

AT

"

Figure 10. Manage Run-Time Environment dialog

Version  Description
Generic Interfaces for Evaluation and Development Boards
Cortex Microcontroller Software Interface Compenents
540 CMSIS-CORE for Cortex-I, SC000, 5C300, ARMyA-M, ARMvE1-M
~ 1180 CMSIS-DSP Library for Cortex-M, SC000, and SC300
130 CMSIS-NN Meural Network Library

1.0.0 CMSIS-RTOS AP for Cortex-M, SCO00. and 5C300
213 CMSIS-RTOS AP for Cortex-M, SCO00. and 5C300
NXP MCUXpresso SDK Peripheral CMSIS Drivers
160 Compiler Extensions for ARM Compiler 5 and ARM Compiler &

Startup, System Setup
NXP MCUXpresso SDK Peripheral Drivers
NXP MCUXpresso SDK RTE Device Project Template
NXP MCUXpresso SDK Utilities
~|6.13.6 File Access on various storage devices
~|6.10.8 User Interface on graphical LCD displays
~ | 713 |Pv4 Networking using Ethernet or Serial protocols

10. Click OK, and a new project is created. The new project is now visible in the left-hand part of Keil yVision. See Figure 11.
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EE ChKailProjects\MyProject01\MyProjectdl.uvprojx - pVisicn 1
File Edit Wiew Project Flash Debug Peripherals Tool

NS d | 4 o | |
£ B € 0| $% | rarget1 =] 45|
Project n B
i device ﬂ

j fsl_device_registers.h

1 LPC55569_cm33_corel.h

_1 LPC35569_cm33_corel_features.h

j systern_LPC5353569_cm33_corel.c

] system_LPC53569_cm33_corel.h
=T startup

] startup_LPC55569_cm33_corel.S

Figure 11. Project

11. In the main menu, go to Project > Options for Target 'Target1'..., and a dialog appears.
12. Select the Target tab.
13. Select Not Used in the Floating Point Hardware option. See Figure 11.

Code Generation
ARM Compiler: |Llse default compiler version j

| Use Cross-Module Optimization
| Use MicroLIB [

Hoating Point Hardware: -

Figure 12. FPU

PowerQuad DSP Coprocessor and Accelerator support

Some LPC platforms (LPC55S6x) contain a hardware accelerator dedicated to common calculations in DSP applications. This

section shows how to turn the PowerQuad (PQ) support for a function on and off.
1. In the main menu, go to Project > Options for Target 'Target1'..., and a dialog appears.
2. Select the C/C++ tab. See Figure 13.
3. In the Include Preprocessor Symbols text box, type the following:
+ RTCESL_PQ_ON—to turn the hardware division and square root support on.
+ RTCESL_PQ_OFF—to turn the hardware division and square root support off.

If neither of these two defines is defined, the hardware division and square root support is turned off by default.
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De\ricel Target | Outputl Listingl User C/Cer Iﬂsm | Linkerl Debug | Uilities |

B

— Prep Symbals

Define: IRTCESL_PQ_ON

Undefine: I

— Language / Code Generation
I™ Erecuteniy Code I Sirict ANSIC Wamings
Optimization: lm ™ Enum Container ahways int All Wamings j'
I~ Optimize for Time [ Plain Charis Signed [T Thumb Mode

™ Split Load and Store Multiple [~ Read-Only Position Independent ™ No Auto Includes
[™ One ELF Section per Function I~ Read-Wiite Position Independent [~ €33 Mode

Include I
Paths

Misc I
Controls

Compiler |- —cpu Cortex-M4fp -D__EVAL -g 00 -apcs=interwork
contral || C:\KeilProjects \MyProject01\RTE
string

Defaults

Figure 13. Preprocessor symbols

4. Click OK in the main dialog.

5. Ensure the PowerQuad moduel to be clocked by calling function RTCESL_PQ_lInit(); prior to the first function using PQ
module calling.

See the device reference manual to verify whether the device contains the PowerQuad DSP Coprocessor and
Accelerator support.

Linking the files into the project
GFLIB requires MLIB to be included too. The following steps show how to include all dependent modules.
To include the library files in the project, create groups and add them.

1. Right-click the Target 1 node in the left-hand part of the Project tree, and select Add Group... from the menu. A new group
with the name New Group is added.

2. Click the newly created group, and press F2 to rename it to RTCESL.
3. Right-click the RTCESL node, and select Add Existing Files to Group 'RTCESL'... from the menu.

4. Navigate into the library installation folder CANXP\RTCESL\CM33_RTCESL_4.7_KEIL\MLIB\Include, and select the m/ib.h
file. If the file does not appear, set the Files of type filter to Text file. Click Add. See Figure 14.
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Lookin: | | Include j = £ Edv 1
Mame : Date modified il
i mlib.h 16.10.2014 9:19 iE |
| MLIB_Abs_F16.h 21.10.2014 9:45 W
| MLB_Abs_F32.h 16.10.2014 9:19

_ | MLB_Add_A32.h 16.10.2014 9:19

_ | MLIB_Add_F1&.h 16.10.2014 9:19

| MLIB_Add_F32.h 16.10.2014 9:19

_ | MLIB_Add4_F16.h 16.10.2014 9:19

| MLIB_Add4 _F32.h 16.10.2014 9:19

| MLIB_BiShift_F16.h 16.10.2014 2:19

| MLIB_BiShift_F32.h 16.10.2014 9:19

-

RALTR il F4E L

1 | n |

R W TG %

Add I
| Close |

File name: |mlib.h

Files of type: | Teut file ("bd; *h; *inc)

Figure 14. Adding .h files dialog

5. Navigate to the parent folder C:\NXP\RTCESL\CM33_RTCESL_4.7_KEIL\MLIB, and select the m/ib.libfile. If the file does
not appear, set the Files of type filter to Library file. Click Add. See Figure 15.

Lookin: | . MLIB ~| & Bk E- |

MName Date modified Ty
/Include 20102014 15:37 Fi
|| MLIB.lib 16.10.2014 9:19 LI

4| (1

Add I
~| Close |

File name: |MLIE.Iib

Files of type: IIJblaryﬁIe {*lib)

Figure 15. Adding .lib files dialog

6. Navigate into the library installation folder C:A\ANXP\RTCESL\CM33_RTCESL_4.7_KEIL\GFLIB\Include, and select the
gfiib.hfile. If the file does not appear, set the Files of type filter to Text file. Click Add.

7. Navigate to the parent folder C:\NXP\ARTCESL\CM33_RTCESL_4.7_KEIL\GFLIB, and select the gfiib.libfile. If the file does
not appear, set the Files of type filter to Library file. Click Add.

8. Now, all necessary files are in the project tree; see Figure 16. Click Close.
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| Project 1 &
- Project: MyProjectll
g Targetl
. J Sowurce Group 1
=5 RTCESL
1 mlib.h
1 MLIB.lib
1 gflib.h
] GFLIB.lib
& omsis
=% Device

Figure 16. Project workspace

Library path setup

The following steps show the inclusion of all dependent modules.
1. In the main menu, go to Project > Options for Target 'Target1'..., and a dialog appears.
2. Select the C/C++ tab. See Figure 17.

3. Inthe Include Paths text box, type the following paths (if there are more paths, they must be separated by ';') or add them
by clicking the ... button next to the text box:

+ "C:\NXP\RTCESL\CM33_RTCESL_4.7_KEIL\MLIB\Include"
+ "C:\NXP\RTCESL\CM33_RTCESL_4.7_KEIL\GFLIB\Include"
4. Click OK.
5. Click OK in the main dialog.
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k] Options for Target ‘Target 1

Devicel Target | Oulpull Listingl User C/Ce+ |.&'sm I Linkerl Debug | Ltilities |

Symbals

Define: I
Undefine: I

— Language / Code Generation

I~ Stict ANSIC e
Optimization: lm I™ Enum Container abways int All'Wamings j'
I Optimize for Time ™ Plain Char is Signed = Thurmb Mode
I~ Split Load and Store Muttiple [~ Read-Cnly Position Independent [~ No Auto Includes
[~ One ELF Section per Function [~ Read-Write Postion Independert [~ C39 Mode

Include ||
Paths

Misc I
Controls

Compiler  |-¢ —cpu Cortex-M0+ -D__EVAL -g -00 —apcs=interwork
control [ C:\KeilProjects \MyProject01\RTE
string

Figure 17. Library path addition

Type the #include syntax into the code. Include the library into a source file. In the new project, it is necessary to create a
source file:

1. Right-click the Source Group 1 node, and Add New Item to Group 'Source Group 1'... from the menu.

2. Select the C File (.c) option, and type a name of the file into the Name box, for example 'main.c. See Figure 18.

: e e o o ompe
v o s or T

Create a new C source file and add it to the projec
C | CFile{c)

@ C++ File {.cpp)
\ﬂ Asm File ()

@ Header File (h)
é Text File (bd)
Qg\ Image File (%
1@ User Code Template

Type: I

Mame: I main.

Location: I C:\KeilProjects\MyProjectd1

Figure 18. Adding new source file dialog

3. Click Add, and a new source file is created and opened up.
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4. In the opened source file, include the following lines into the #include section, and create a main function:

#include "mlib.h"
#include "gflib.h"

int main (void)
{

while (1) ;
}

When you click the Build (F7) icon, the project will be compiled without errors.

1.4 Library integration into project (IAR Embedded Workbench)

This section provides a step-by-step guide on how to quickly and easily include the GFLIB into an empty project or any
MCUXpresso SDK example or demo application projects using IAR Embedded Workbench. This example uses the default
installation path (C:\NXP\RTCESL\CM33_RTCESL_4.7_IAR). If you have a different installation path, use that path instead. If
any MCUXpresso SDK project is intended to use (for example hello_world project) go to Linking the files into the project chapter
otherwise read next chapter.

New project (without MCUXpresso SDK)

This example uses the NXP LPC55S69 part, and the default installation path (C:\NXP\RTCESL\CM33_RTCESL_4.7_IAR) is
supposed. To start working on an application, create a new project. If the project already exists and is opened, skip to the next
section. Perform these steps to create a new project:

1. Launch IAR Embedded Workbench.

2. In the main menu, select Project > Create New Project... so that the "Create New Project" dialog appears. See Figure 19.

-~ =

Tool chain: | AFiM -

Froject templates:

[ asm -
[ C++

-+ DLIB [T, Co+ with exceptions and ATTI)
DLIB [C, Extended Embedded C++)

N el WOy R S RpppRpRp ey Y P

m m
00

Description:

C project uzing default tool settings inchuding an emply main.c file.

Figure 19. Create New Project dialog

3. Expand the C node in the tree, and select the "main" node. Click OK.

4. Navigate to the folder where you want to create the project, for example, C:\IARProjects\MyProject01. Type the name of the
project, for example, MyProject01. Click Save, and a new project is created. The new project is now visible in the left-hand
part of IAR Embedded Workbench. See Figure 20.
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File

Tool

& 1AR Embedded Workbench IDE

Edit View Project Sirmulator

s Window Help

DeHI &l iRl o

=,

Workspace

x

[ Debug

main.c |

7

Files

main.c
L@ 3 Output

Figure 20. New project

=lalMyProjectdl -Deb... |« | |

En O

x

int mainf()
{
return 0;

}

In the main menu, go to Project > Options..., and a dialog appears.

In the Target tab, select the Device option, and click the button next to the dialog to select the MCU. In this example, select
NXP > LPC55S69 > NXP LPC55S69_core0. Select None in the FPU option.The DSP instructions group is required please
check the DSP Extensions checkbox if not checked. Click OK. See Figure 21.

Category:

Static Analysis
Runtime Checking

C/C++ Compiler
Assembler
Qutput Converter
Custom Build
Build Actions
Linker
Debugger
Simulator

Angel

CMSIS DAP

GDE Server

IAR. ROM-monitor
I-jet/ITAGjet
Jink/1-Trace
TI Stellaris
Macraigor

PE micro

RDI

STALINK
Third-Party Driver
TIXDS

S

Library Options 2
Target Output

Processor variant

(O Core

MISRALC:2004
Library Configuration

MISRALC:1358
Library Options 1

Cortex-M33

(® Device

NXP LPC55565_corel

OCMsIS-Pack  Mlone

Endian mode
Little:
Big

FPU

Floating point settings

None

19 D reqisters

DSP Extension
Advanced SIMD {NEON)

TrustZone

Mode | Non-secure ~

Figure 21. Options dialog

[ ok

] [ Cancel

PowerQuad DSP Coprocessor and Accelerator support

Some LPC platforms (LPC55S6x) contain a hardware accelerator dedicated to common calculations in DSP applications. Only
functions runing faster through the PowerQuad module than the core itself are supported and targeted to be calculated by the
PowerQuad module. This section shows how to turn the PowerQuad (PQ) support for a function on and off.

1.
2.
3.

In the main menu, go to Project > Options..., and a dialog appears.

In the left-hand column, select C/C++ Compiler.

In the right-hand part of the dialog, click the Preprocessor tab (it can be hidden in the right-hand side; use the arrow icons

for navigation).
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4. In the text box (at the Defined symbols: (one per line)), type the following (See Figure 22):
+ RTCESL_PQ_ON—to turn the PowerQuad support on.
+ RTCESL_PQ_OFF—to turn the PowerQuad support off.

If neither of these two defines is defined, the hardware division and square root support is turned off by default.

Options for node "MyProject01” | P |

Categony: Factory Settings

General Options [ Multifile Compilation

Static Analysis Discard Unused Publics
Runtime Chedking

[ Language 2 | Code | Optimizations | Output | List | Preprocessor [[« ]

Assembler
Output Converter [ lgnore standard include directories

Custom Build Additional include directories: jone per ling)
Build Actions " E]

Linker
Debuager
Simulator
Angel
CMSIS DAP Preinclude file:
GDE Server E]
TAR. ROM-monitor
T4et/TTAGIet Defined symbols: (one per line)
1ink{1-Trace RTCESL_FQ_ON A || Preprocessor outpit to file
TI Stellaris Preserve comments
Macraigor 1 Generate Hine directives

PE micro

RDI

ST-LIMK
Third-Party Driver
TI XDS

QK. ] l Cancel

L. A

Figure 22. Defined symbols

5. Click OK in the main dialog.

6. Ensure the PowerQuad moduel to be clocked by calling function RTCESL_PQ_lInit(); prior to the first function using PQ
module calling.

See the device reference manual to verify whether the device contains the PowerQuad DSP Coprocessor and
Accelerator support.

Library path variable
To make the library integration easier, create a variable that will hold the information about the library path.
1. In the main menu, go to Tools > Configure Custom Argument Variables..., and a dialog appears.

2. Click the New Group button, and another dialog appears. In this dialog, type the name of the group PATH, and click OK.
See Figure 23.
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1 ' Configure Custom Argument Variables

Workspace | Global

Enable Group
Troup...
MNew Group | 5= | E_ B
Fiable...
M : 3
ame PATH iable. ..
lete
oK l [ Cancel IF
prt...
Expand/Collapse All
[ Hide disabled groups
oK l l Cancel

A

Figure 23. New Group

Click on the newly created group, and click the Add Variable button. A dialog appears.

Type this name: RTCESL_LOC

To set up the value, look for the library by clicking the '..." button, or just type the installation path into the box:

C:ANXP\RTCESL\CM33_RTCESL_4.7_IAR. Click OK.
In the main dialog, click OK. See Figure 24.

# ' Configure Custom Argument Variables [ = |
Workspace | Global
[ pATH Disable Group
n
Add Variable ==

Name: |RTCESL_LOC |
Value: |C:\,NXP\,RTCESL_CM33_RTCESL_X.X_IAR |D

[ OK. ][ Cancel ]

Figure 24. New variable

Linking the files into the project

GFLIB requires MLIB to be included too. The following steps show the inclusion of all dependent modules.
To include the library files into the project, create groups and add them.
1.

Go to the main menu Project > Add Group...

. Type RTCESL, and click OK.

Click on the newly created node MLIB, and go to the main menu Project > Add Files... See Figure 26.

. Navigate into the library installation folder C:\NXP\RTCESL\CM33_RTCESL_4.7_IAR\MLIB\Include, and select the m/ib.h

2
3. Click on the newly created node RTCESL, go to Project > Add Group..., and create a MLIB subgroup.
4.
5

file. (If the file does not appear, set the file-type filter to Source Files.) Click Open. See Figure 25.
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6. Navigate into the library installation folder C:\NXP\RTCESL\CM33_RTCESL_4.7_IAR\MLIB, and select the m/ib.afile. If the

file does not appear, set the file-type filter to Library / Object files. Click Open.

T |
b System (C:) » MXP » RTCESL » CM33RTCESLXXIAR » MLIB » Include
ee—
i MName . Date modified Type
. mlib.h 16.10.20159:38 H File
| MLIB_Abs_F16.h 16.10.20159:38 H File
Figure 25. Add Files dialog

7. Click on the RTCESL node, go to Project > Add Group..., and create a GFLIB subgroup.
8. Click on the newly created node GFLIB, and go to the main menu Project > Add Files....

9. Navigate into the library installation folder C:ANXP\RTCESL\CM33_RTCESL_4.7_IAR\GFLIB\Include, and select the
file. (If the file does not appear, set the file-type filter to Source Files.) Click Open.

gfiib.h

10. Navigate into the library installation folder C:ANXP\RTCESL\CM33_RTCESL_4.7_IAR\GFLIB, and select the gfiib.afile. If

the file does not appear, set the file-type filter to Library / Object files. Click Open.

11. Now you will see the files added in the workspace. See Figure 26.

Workspace x
[ Debug -

Files o H
B F MyProject01 - Debug * v
2 CIRTCESL
& CaMLIB
| —DOMUBA
| L— & mlib_FP.h
o Lo ER
F— [ GFLIB.a
L— [ gflib_FPh
FrIdin. c *
=1 [ Qutput

Figure 26. Project workspace

Library path setup

The following steps show the inclusion of all dependent modules:
1. In the main menu, go to Project > Options..., and a dialog appears.
2. In the left-hand column, select C/C++ Compiler.

3. In the right-hand part of the dialog, click on the Preprocessor tab (it can be hidden in the right; use the arrow icons
for navigation).

4. In the text box (at the Additional include directories title), type the following folder (using the created variable):
+ $RTCESL_LOCS$\MLIB\Include
+ $RTCESL_LOCS$\GFLIB\Include

5. Click OK in the main dialog. See Figure 27.
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Categony:

,

===

General Options
Static Analysis
Runtime Checking

C/C++ Compiler

Assembler
Qutput Converter
Custom Build
Build Actions
Linker
Debugger
Simulator
Angel
CMS3IS DAP
GDE Server
IAR ROM-monitor
I4et/ITAGjet
J-Link/1-Trace
TI Stellaris
Macraigor
PE micro
RDI
ST-LIMK
Third-Party Driver
TI XDS

[] Multi-file Campilation

Dizcard Unuzed Publice

Factary Settings

| Language 1 I Language 2 I Code I Cptimizations I Output I List

||:< b

[ Ignore standard include directories

Additional include directories: (one per ling)

SRTCESL_LOCS\MLIBinclude

SRTCESL_LOCS\GFLIBnclude|

Preinclude file:

Defined symbaols: (one per ling)

.

[ Preprocessor output to file

Preserve comments

Generate Hine directives

]

Figure 27. Library path adition

ak. ] [ Cahicel

Type the #include syntax into the code. Include the library included into the main.cfile. In the workspace tree, double-click the
main.cfile. After the main.c file opens up, include the following lines into the #include section:

#include "mlib.h"
#include "gflib.h"

When you click the Make icon, the project will be compiled without errors.
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Chapter 2
Algorithms in detall

2.1 GFLIB_Sin

The GFLIB_Sin function implements the polynomial approximation of the sine function. It provides a computational method for
the calculation of a standard trigonometric sine function sin(x), using the 9™ order Taylor polynomial approximation. The Taylor
polynomial approximation of a sine function is expressed as follows:

. 3 x5 x7 ¥
s1n(x):x-%+%-% +%

Figure 28.

sin(x) = x(d + xAd3+ xAd s+ xHd7 + x2d))))

Figure 29.

where the constants are:

The fractional arithmetic is limited to the range <-1; 1), so the input argument can only be within this range. The input argument
is the multiplier of : sin(1T - X), where the user passes the x argument. Example: if the input is -0.5, it corresponds to -0.51.

The fractional function sin(T - x) is expressed using the 9t order Taylor polynomial as follows:

sin(mx) = x(c; + x2c; + xXcs + xH(c; + x2co))))

Figure 30.

where:
¢ =dl=n
3= d3‘7r3 = — %.3
cs=dsm5= %,5
= d7.7r7 =—-3
cy=don9=g

2.1.1 Available versions

The function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the GFLIB_Sin function are shown in the following table:
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Table 2. Function versions

Function name | Input type | Result type Description

GFLIB_Sin_F16 |frac16_t frac16_t Calculation of the sin(1T - x), where the input argument is a 16-bit fractional value
normalized to the range <-1 ; 1) that represents an angle in radians within the
range <-r; ). The output is a 16-bit fractional value within the range <-1; 1).

2.1.2 Declaration

The available GFLIB_Sin functions have the following declarations:

fracl6e _t GFLIB Sin Flé6(fracl6 t flé6Angle)

2.1.3 Function use

The use of the GFLIB_Sin function is shown in the following examples:

Fixed-point version:
#include "gflib.h"

static fracl6é t fl6Result;
static fracl6 t fl6Angle;

void main (void)
{
fl6Angle = FRAC16(0.333333); /* fl6Angle = 0.333333 [60°] */

/* fl6Result = sin(fl6Angle); (n * fl6Angle[rad]) = deg * (mx / 180) */
fl6Result = GFLIB_Sin F16 (fl6Angle) ;

2.2 GFLIB_Cos

The GFLIB_Cos function implements the polynomial approximation of the cosine function. This function computes the cos(x) using
the ninth-order Taylor polynomial approximation of the sine function, and its equation is as follows:

cos(x) = sin[% + M]
Figure 31.

Because the fractional arithmetic is limited to the range <-1 ; 1), the input argument can only be within this range. The input
argument is the multiplier of 1r: cos(1T - x), where the user passes the x argument. For example, if the input is -0.5, it corresponds
to -0.51r.

2.2.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the GFLIB_Cos function are shown in the following table:
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Table 3. Function versions

Function name | Input type | Result type Description

GFLIB_Cos_F16 |frac16_t frac16_t Calculation of cos(1 - x), where the input argument is a 16-bit fractional value,
normalized to the range <-1 ; 1) that represents an angle in radians within the
range <- 1; ). The output is a 16-bit fractional value within the range <-1; 1).

2.2.2 Declaration

The available GFLIB_Cos functions have the following declarations:

fracl6 tGFLIB Cos_Fl6(fraclée t flé6Angle)

2.2.3 Function use

The use of the GFLIB_Cos function is shown in the following examples:

Fixed-point version:
#include "gflib.h"

static fracl6é t fl6Result;
static fracl6 t fl6Angle;

void main (void)
{

fl6Angle

FRAC16(0.333333) ; /* fl6Angle = 0.333333 [60°] */

/* fl6Result = cos(fl6Angle); fl6Angle[rad] = deg * (mx / 180) */
fl6Result = GFLIB Cos F16(f16Angle);

2.3 GFLIB_Tan

The GFLIB_Tan function provides a computational method for calculation of a standard trigonometric tangent function tan(x),
using the piece-wise polynomial approximation. Function tan(x) takes an angle and returns the ratio of two sides of a right-angled
triangle. The ratio is the length of the side opposite the angle divided by the length of the side adjacent to the angle.

sin(x)

tan(x) = o5

Figure 32.

Because both sin(x) and cos(x) are defined in interval <-11 ; >, the function tan(x) is equal to zero when sin(x)=0 and is equal to
infinity when cos(x)=0. The graph of tan(x) is shown in the following figure:
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Figure 33. Course of the function GFLIB_Tan

The fractional arithmetic is limited to the range <-1 ; 1) so the input argument can only be within this range. The input argument is
the multiplier of 1r: tan(1r - X) where you pass the x argument. Example: if the input is -0.5, it corresponds to -0.51r. The output of
the function is limited to the range <-1 ; 1) for the fractional arithmetic. For the points where the function is not defined, the output
is fractional -1.

2.3.1 Available versions
The function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the GFLIB_Tan function are shown in the following table:

Table 4. Function versions

Function name | Inputtype | Result type Description

GFLIB_Tan_F16 |frac16_t frac16_t Calculation of the tan(TT - x) where the input argument is a 16-bit fractional value
normalized to the range <-1; 1) that represents an angle in radians within the
range <-11 ; ). The output is a 16-bit fractional value within the range <-1; 1).

2.3.2 Declaration

The available GFLIB_Tan functions have the following declarations:

fraclé t GFLIB Tan F16(fracl6 t fl6Angle)

2.3.3 Function use

The use of the GFLIB_Tan function is shown in the following examples:

Fixed-point version:
#include "gflib.h"

static fracl6 t fl6Result;
static fraclé t fl6Angle;

void main (void)

{

fl16Angle = FRAC16(0.1); /* fl6eAngle = 0.1 [18°] */
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/* fl6Result = tan(fl6Angle); (m * fl6Angle[rad]) = deg * (mx / 180) */
fl6Result = GFLIB Tan_ F16 (fl6Angle);

2.4 GFLIB_Asin

The GFLIB_Asin function provides a computational method for calculation of a standard inverse trigonometric arcsine function
arcsin(x), using the piece-wise polynomial approximation. Function arcsin(x) takes the ratio of the length of the opposite side to
the length of the hypotenuse and returns the angle.

151 E : 4

Figure 34. Course of the function GFLIB_Asin

The fractional arithmetic is limited by the range <-1;1) so the output can only be within this range. This range corresponds to the
angle <-1;1). Example: if the output is -0.5 it corresponds to -0.51r.
2.4.1 Available versions
The function is available in the following versions:
» Fractional output - the output is the fractional portion of the result; the result is within the range <-1;1). The result may saturate.

The available versions of the GFLIB_Asin function are shown in the following table:

Table 5. Function versions

Function name | Inputtype | Result type Description

GFLIB_Asin_F16 |frac16_t frac16_t Calculation of the arcsin(x) / ™ where the input argument is a 16-bit fractional
within the range <-1;1). The output is a 16-bit fractional value within the range
<-1;1) that represents an angle in radians within the range <-1r;m).

2.4.2 Declaration

The available GFLIB_Asin functions have the following declarations:

fraclé t GFLIB Asin Fl16(fraclée t fléVal)

2.4.3 Function use

The use of the GFLIB_Asin function is shown in the following examples:
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Fixed-point version:
#include "gflib.h"

static fracl6 t fl6Result;
static fraclé t flé6Value;

void main (void)
{
flé6Value = FRAC16(0.5); /* fléValue = 0.5 */
/* fl6Result = arcsin(flévValue); */
fl6Result = GFLIB Asin_ Fl6(flé6Value);

2.5 GFLIB_Acos

The GFLIB_Acos function provides a computational method for calculation of a standard inverse trigonometric arccosine function
arccos(x), using the piece-wise polynomial approximation. Function arccos(x) takes the ratio of the length of the adjacent side to

the length of the hypotenuse and returns the angle.

Figure 35. Course of the function GFLIB_Acos

The fractional arithmetic is limited by the range <-1;1) so the output can only be within this range. This range corresponds to the

angle <-1;1). Example: if the output is -0.5 it corresponds to -0.51r.

2.5.1 Available versions

The function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1;1). The result may saturate.

The available versions of the GFLIB_Acos function are shown in the following table:

Table 6. Function versions

Function name

Input type

Result type

Description

GFLIB_Acos_F16

frac16_t

frac16_t

Calculation of the arccos(x) / Tr where the input argument is a 16-bit fractional
within the range <-1;1). The output is a 16-bit fractional value within the range
<-1;1) that represents an angle in radians within the range <-r;1m).
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2.5.2 Declaration

The available GFLIB_Acos functions have the following declarations:

fraclé t GFLIB Acos Fl6(fracl6 t flé6Val)

2.5.3 Function use

The use of the GFLIB_Acos function is shown in the following examples:

Algorithms in detail

Fixed-point version:
#include "gflib.h"

static fracl6_t fl6Result;
static fraclé6 t flé6Value;

void main (void)

{
fl6Value = FRAC16(0.5); /* fl6Value = 0.5 */

/* fl6Result = arccos (fl6Value); */
fl6Result = GFLIB Acos Fl16(fl6Value);

2.6 GFLIB_Atan

The GFLIB_Atan function implements the polynomial approximation of the arctangent function. It provides a computational
method for calculating the standard trigonometric arctangent function arctan(x), using the piece-wise minimax polynomial
approximation. Function arctan(x) takes a ratio, and returns the angle of two sides of a right-angled triangle. The ratio is the length
of the side opposite to the angle divided by the length of the side adjacent to the angle. The graph of the arctan(x) is shown in the

following figure:
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Figure 36. Course of the GFLIB_Atan function

The fractional arithmetic version of the GFLIB_Atan function is limited to a certain range of inputs <-1; 1). Because the arctangent
values are the same, with just an opposite sign for the input ranges <-1; 0) and <0 ; 1), the approximation of the arctangent function
over the entire defined range of input ratios can be simplified to the approximation for a ratio in the range <0 ; 1). After that, the
result will be negated, depending on the input ratio.

2.6.1 Available versions

The function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-0.25 ; 0.25), which
corresponds to the angle <-1/ 4 ; 1/ 4).

The available versions of the GFLIB_Atan function are shown in the following table:

Table 7. Function versions

Function name | Input type | Result type Description

GFLIB_Atan_F16 |frac16_t frac16_t Input argument is a 16-bit fractional value within the range <-1; 1). The output
is the arctangent of the input as a 16-bit fractional value, normalized within the
range <-0.25 ; 0.25), which represents an angle (in radians) in the range <-17 /
4 ;1 /4)<-45°; 45°).

2.6.2 Declaration

The available GFLIB_Atan functions have the following declarations:

fracl6 tGFLIB Atan Flé6(fraclée t flé6Val)

2.6.3 Function use

The use of the GFLIB_Atan function is shown in the following examples:
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Fixed-point version:
#include "gflib.h"

static fracl6 t fl6Result;
static fracle6_t fleval;

void main (void)
{
fléval = FRAC16(0.1666666) ; /* fl6Val = 0.1666666 (30°) */

/* fl6Result = atan(fl6Val); fl6Result * 180 => angle[degree]
fl6Result = GFLIB Atan F16(fl6Val);

*/

2.7 GFLIB_AtanYX

The GFLIB_AtanYX function computes the angle, where its tangent is y / x (see the figure below). This calculation is based on the

input argument division (y divided by x), and the piece-wise polynomial approximation.

Atanx(<-1, 1=, <1, 1=)

o e S
e e G L
o e L
T e ot
e e
e

Atany ¥y, x)

Figure 37. Course of the GFLIB_AtanYX function
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The first parameter Y is the ordinate (the x coordinate), and the second parameter X is the abscissa (the x coordinate). The
counter-clockwise direction is assumed to be positive, and thus a positive angle is computed if the provided ordinate (Y) is
positive. Similarly, a negative angle is computed for the negative ordinate. The calculations are performed in several steps. In
the first step, the angle is positioned within the correct half-quarter of the circumference of a circle by dividing the angle into two
parts: the integral multiple of 45° (half-quarter), and the remaining offset within the 45° range. Simple geometric properties of the
Cartesian coordinate system are used to calculate the coordinates of the vector with the calculated angle offset. In the second
step, the vector ordinate is divided by the vector abscissa (y / x) to obtain the tangent value of the angle offset. The angle offset
is computed by applying the GFLIB_Atan function. The sum of the integral multiple of half-quarters and the angle offset within a
single halfquarter form the angle is computed.

The function returns 0 if both input arguments equal 0, and sets the output error flag; in other cases, the output flag is cleared.
When compared to the GFLIB_Atan function, the GFLIB_AtanYX function places the calculated angle correctly within the
fractional range <-11 ; Tr>.

In the fractional arithmetic, both input parameters are assumed to be in the fractional range <-1; 1). The output is within the range
<-1; 1), which corresponds to the real range <-11 ; ).

2.7.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1), which corresponds
to the angle <-1r; m).

The available versions of the GFLIB_AtanYX function are shown in the following table:

Table 8. Function versions

Function name Input type Output type Result type

Y X Error flag

GFLIB_AtanYX_F16 |frac16_t frac16_t bool_t * frac16_t

The first input argument is a 16-bit fractional value that contains the ordinate of the input vector (y
coordinate). The second input argument is a 16-bit fractional value that contains the abscissa of the
input vector (x coordinate). The result is the arctangent of the input arguments as a 16-bit fractional
value within the range <-1; 1), which corresponds to the real angle range <- 11; 7). The function sets the
boolean error flag pointed to by the output parameter if both inputs are zero; in other cases, the output
flag is cleared.

2.7.2 Declaration

The available GFLIB_AtanYX functions have the following declarations:

fraclé tGFLIB AtanYX Fl6(fraclé6 t fl6Y, fracl6 t f16X, bool t *pbErrFlag)

2.7.3 Function use

The use of the GFLIB_AtanYX function is shown in the following examples:

Fixed-point version:
#include "gflib.h"
static fracl6é t fl6Result;
static fraclé t fle6Y, fl6X;

static bool t bErrFlag;

void main (void)
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fley
flex

FRAC16
FRACL16

/* fl6Result

(0.9);
(0.3);

= atan(flé6Y / f16X); fl6Result * 180 => angle [degree] */
fl6Result = GFLIB AtanYX Fle6(fl6Y, fl6X, &bErrFlag);

Algorithms in detail

/* fleY
/* flex

9.9 =/
9.3 =/

2.8 GFLIB_Sqrt

The GFLIB_Sqrt function returns the square root of the input value. The input must be a non-negative number, otherwise the
function returns undefined results. See the following equation:

Figure 38. Algorithm formula

GFLIB_Sqrt(x) = . x=0
undefined, x<0

2.8.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The function is only
defined for non-negative inputs. The function returns undefined results out of this condition.

The available versions of the GFLIB_Sqrt function are shown in the following table:

Table 9. Function versions

Function name Input Result Description
type type

GFLIB_Sqrt_F16 frac16_t |frac16_t | The input value is a 16-bit fractional value, limited to the range <0 ; 1). The function
is not defined out of this range. The output is a 16-bit fractional value within the range
<0;1).

GFLIB_Sqrt_F16l |frac32_t |frac16_t | The input value is a 32-bit fractional value, limited to the range <0 ; 1). The function
is not defined out of this range. The output is a 16-bit fractional value within the range
<0;1).

2.8.2 Declaration

The available GFLIB_Sqrt functions have the following declarations:

fraclé t GFLIB Sqrt Fl6(fraclée t flé6Val)
fracl6e_t GFLIB Sqrt Fl6l(frac32 t f32val)

2.8.3 Function use

The use of the GFLIB_Sqrt function is shown in the following examples:

Fixed-point version:

#include "gflib.h"

static fracl6é t fl6Result;
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static fraclé t flé6Val;
void main (void)

{

fléval = FRAC16(0.5); /* fleval = 0.5 */

/* fl6Result = sqgrt(fleval) */
fl6Result = GFLIB Sqrt Fl6(fléVval);

2.9 GFLIB_Limit

The GFLIB_Limit function returns the value limited by the upper and lower limits. See the following equation:

min, x <min
GFLIB_Limit(x, min, max) = {max, x> max
X, else

Figure 39. Algorithm formula

2.9.1 Available versions
This function is available in the following versions:

« Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the GFLIB_Limit functions are shown in the following table:

Table 10. Function versions

Function name Input type Result Description
t
Input Lower Upper ype
limit limit

GFLIB_Limit_F16 |[frac16_t |frac16_t |[frac16_t |frac16_t | The inputs are 16-bit fractional values within the range <-1;

1). The function returns a 16-bit fractional value in the range
<f16LLim ; f16ULIim>.

GFLIB_Limit_F32 |[frac32_t |frac32_t |[frac32_t |frac32_t | The inputs are 32-bit fractional values within the range <-1;
1). The function returns a 32-bit fractional value in the range
<f32LLim ; f32ULim>.

2.9.2 Declaration
The available GFLIB_Limit functions have the following declarations:
fracl6 t GFLIB Limit F16(fracl6 t flé6Val, fraclé t f16LLim, fracl6 t f16ULim)

frac32 t GFLIB Limit F32(frac32 t £32Val, frac32 t £f32LLim, frac32 t £32ULim)

2.9.3 Function use

The use of the GFLIB_Limit function is shown in the following examples:
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Fixed-point version:
#include "gflib.h"
static fraclé t fl6Val, £f16ULim, f16LLim, fl6Result;

void main (void)

{
f16ULim = FRAC16(0.8);
f16LLim FRAC16(-0.3) ;
fl6vVal = FRAC16(0.9);

fl6Result = GFLIB Limit F16(fl6Val, fl6LLim, £16ULim);

2.10 GFLIB_LowerLimit

The GFLIB_LowerLimit function returns the value limited by the lower limit. See the following equation:

o min, x <min
GFLIB_LowerLimit(x, min) = X else

Figure 40. Algorithm formula

2.10.1 Awvailable versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may saturate.
The available versions of the GFLIB_LowerLimit functions are shown in the following table:

Table 11. Function versions

Function name Input type Result Description
Input Lower type
limit

<f16LLIm ; 1).

GFLIB_LowerLimit_ F16 |frac16_t |frac16_t |frac16_t | The inputs are 16-bit fractional values within the range <-1 ;
1). The function returns a 16-bit fractional value in the range

<f32LLim ; 1).

GFLIB_LowerLimit_F32 |frac32_t |frac32_t |frac32_t | The inputs are 32-bit fractional values within the range <-1 ;
1). The function returns a 32-bit fractional value in the range

2.10.2 Declaration

The available GFLIB_LowerLimit functions have the following declarations:

fracl6é t GFLIB LowerLimit F16(fracl6 t fl6Val, fracl6é t f16LLim)
frac32 t GFLIB LowerLimit F32(frac32 t £32Val, frac32 t f£32LLim)
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2.10.3 Function use

The use of the GFLIB_LowerLimit function is shown in the following examples:

Fixed-point version:
#include "gflib.h"
static fraclé t flé6Val, fl6LLim, fl6Result;

void main (void)

{
f16LLim = FRAC16(0.3);
fleval FRAC16(0.1);

fl6Result = GFLIB LowerLimit F16(fl16Val, f16LLim);

2.11 GFLIB_UpperLimit

The GFLIB_UpperLimit function returns the value limited by the upper limit. See the following equation:

o max, X > max
GFLIB_UpperLimit (x, max) = { X else

Figure 41. Algorithm formula

2.11.1 Available versions
This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the GFLIB_UpperLimit functions are shown in the following table:

Table 12. Function versions

Function name Input type Result Description
t
Input Upper ype
limit

GFLIB_UpperLimit_F16 |frac16_t |frac16_t |frac16_t | The inputs are 16-bit fractional values within the range <-1 ;

1). The function returns a 16-bit fractional value in the range
<-1; f16ULIm>.

GFLIB_UpperLimit_F32 |frac32_t |frac32_t |frac32_t | The inputs are 32-bit fractional values within the range <-1 ;

1). The function returns a 32-bit fractional value in the range
<-1; f32ULim>.

2.11.2 Declaration

The available GFLIB_UpperLimit functions have the following declarations:

fracl6é t GFLIB UpperLimit F16(fracl6é t fl6Val, fracl6 t £f16ULim)
frac32_t GFLIB UpperlLimit F32(frac32_t £32val, frac32_ t f32ULim)
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The use of the GFLIB_UpperLimit function is shown in the following examples:

Fixed-point version:

#include "gflib.h"

void main (void)

{
f16ULim = FRAC16(0.3);
fleval = FRAC16(0.9);

fl6Result = GFLIB UpperLimit F16(fl6Val,

static fraclé t fl6Val, f16ULim, fl6Result;

£16ULim) ;

2.12 GFLIB_VectorLimit

The GFLIB_VectorLimit function returns the limited vector by an amplitude. This limitation is calculated to achieve the zero

angle error.

Out: B,

Figure 42. Input and releated output

Qut: A

A

The GFLIB_VectorLimit function limits the amplitude of the input vector. The input vector a, b components, are passed into the
function as the input arguments. The resulting limited vector is transformed back into the a, 6 components. The limitation is

performed according to the following equations:

Figure 43. Algorithm formulas

\’a2 +b% <lim

else
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b, \’az +b% <lim
b W, else

where:
* a, b are the vector coordinates
* a* b* are the vector coordinates after limitation
¢ lim is the maximum amplitude
The relationship between the input and limited output vectors is obvious from Figure 42.
If the amplitude of the input vector is greater than the input Lim value, the function calculates the new coordinates from the Lim
value; otherwise the function copies the input values to the output.
2.12.1 Available versions
The function is available in the following versions:
 Fractional output - the output is the fractional portion of the result; the result is within the range <-1;1). The result may saturate.

The available versions of the GFLIB_VectorLimit functions are shown in the following table:

Table 13. Function versions

Function name Input type Output type Result
type

Input Limit

GFLIB_VectorLimit_F16 GFLIB_VECTORLIMIT_T_F16 * frac16_t | GFLIB_VECTORLIMIT_T_F16 * void

Limitation of a two-component 16-bit fractional vector within the range <-1;1) with a 16-bit
fractional limitation amplitude. The function returns a two-component 16-bit fractional vector.

2.12.2 GFLIB_VECTORLIMIT_T_F16 type description

Variable name Input type Description
f16A frac16_t A-component; 16-bit fractional type.
f16B frac16_t B-component; 16-bit fractional type

2.12.3 Declaration

The available GFLIB_VectorLimit functions have the following declarations:

fracl6_t GFLIB_VectorLimit F16(const GFLIB VECTORLIMIT T F16 *psVectorIn, fracl6_t fl6Lim,
GFLIB VECTORLIMIT T F16 *psVectorOut)

2.12.4 Function use

The use of the GFLIB_VectorLimit function is shown in the following examples:
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Fixed-point version:

#include "gflib.h"

static GFLIB VECTORLIMIT T F16 sVector, sResult;
static fracl6_t fl6MaxAmpl;

void main (void)

{
fléMaxAmpl = FRAC16(0.8);

sVector.f16A = FRACl6(-0.79);

sVector.f1l6B = FRAC16(0.86) ;

GFLIB VectorLimit F16(&sVector, flé6MaxAmpl, &sResult);

2.13 GFLIB_VectorLimit1

The GFLIB_VectorLimit1 function returns the limited vector by an amplitude. This limitation is calculated to achieve that the first

component remains unchanged (if the limitation factor allows).

Out: B

L J

Figure 44. Input and releated output

The GFLIB_VectorLimit1 function limits the amplitude of the input vector. The input vector a, b components are passed to the
function as the input arguments. The resulting limited vector is transformed back into the a, 6 components. The limitation is

performed according to the following equations:
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{ a, la| <lim

limesgn(a), else

b* =

b, \b| <\lin — a**
\’limz—a*2 esgn(b), else

where:
* a, b are the vector coordinates
* a* b* are the vector coordinates after limitation
* lim is the maximum amplitude
The relationship between the input and limited output vectors is shown in Figure 44.
If the amplitude of the input vector is greater than the input Lim value, the function calculates the new coordinates from the Lim
value; otherwise the function copies the input values to the output.
2.13.1 Available versions
The function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the GFLIB_VectorLimit1 function are shown in the following table:

Table 14. Function versions

Function name Input type Output type Result
type

Input Limit

GFLIB_VectorLimit1_F16 GFLIB_VECTORLIMIT_T_F16 * frac16_t | GFLIB_VECTORLIMIT_T_F16 * void

Limitation of a two-component 16-bit fractional vector within the range <-1 ; 1) with a 16-bit
fractional limitation amplitude. The function returns a two-component 16-bit fractional vector.

2.13.2 GFLIB_VECTORLIMIT_T_F16 type description

Variable name Input type Description
f16A frac16_t A-component; 16-bit fractional type.
f16B frac16_t B-component; 16-bit fractional type.

2.13.3 Declaration

The available GFLIB_VectorLimit1 functions have the following declarations:

fracl6_t GFLIB VectorLimitl F16(const GFLIB VECTORLIMIT T F16 *psVectorIn, fracl6 t flé6Lim,
GFLIB VECTORLIMIT T F16 *psVectorOut)
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2.13.4 Function use

The use of the GFLIB_VectorLimit1 function is shown in the following examples:

Fixed-point version:
#include "gflib.h"

static GFLIB_VECTORLIMIT T F16 sVector, sResult;
static fracl6 t fl6MaxAmpl;

void main (void)

{
fl6MaxAmpl = FRAC16(0.5);
sVector.fl6A = FRAC1l6(-0.4);
sVector.f16B = FRAC16(0.2);

GFLIB VectorLimitl F16(&sVector, fl6MaxAmpl, &sResult);

2.14 GFLIB_Hyst

The GFLIB_Hyst function represents a hysteresis (relay) function. The function switches the output between two predefined
values. When the input is higher than the upper threshold, the output is high; when the input is lower than the lower threshold, the
output is low. When the input is between the two thresholds, the output retains its value. See the following figure:
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Figure 45. GFLIB_Hyst functionality

The four points in the figure are to be set up in the parameters structure of the function. For a proper functionality, the HystOn point
must be greater than the HystOff point.

2.14.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result, and the result is within the range <-1; 1).
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The available versions of the GFLIB_Hyst function are shown in the following table.

Table 15. Function versions
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Function name Input Parameters Result Description
type type
GFLIB_Hyst_F16 frac16_t | GFLIB_HYST_T_F16 * frac16_t | The input is a 16-bit fractional value within the
range <-1; 1). The output is a two-state 16-bit
fractional value.
2.14.2 GFLIB_HYST_T_F16
Variable name Input Description
type
f16HystOn frac16_t | The point where the output sets the output to the f160utValOn value when the input rises.
Set by the user.
f16HystOff frac16_t | The point where the output sets the output to the f160utValOff value when the input falls.
Set by the user.
f160utValOn frac16_t | The ON value. Set by the user.
f160utValOff frac16_t | The OFF value. Set by the user.
f160utState frac16_t | The output state. Set by the algorithm. Must be initialized by the user.

2.14.3 Declaration

The available GFLIB_Hyst functions have the following declarations:

fracl6e t GFLIB Hyst Fl6(fraclé6 t fl6Val, GFLIB HYST T F16 *psParam)

2.14.4 Function use

The use of the GFLIB_Hyst function is shown in the following examples:

Fixed-point version:

void main (void)

{

fl6Result =

#include "gflib.h"

static fracl6 t fl6Result, fl6InVal;
static GFLIB_HYST T F16 sParam;

f16Inval = FRACl6(-0.11);
sParam.fl6HystOn = FRAC16(0.5);
sParam.fl6HystOff = FRAC16(-0.1);
sParam.fl60utValOn = FRAC16(0.7);
sParam.fl60utValOff = FRAC16(0.3);
sParam.floOutState = FRAC1l6(0.0);

GFLIB Hyst F16(fl16InVal, &sParam);
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2.15 GFLIB_Lut1D

The GFLIB_Lut1D function implements the one-dimensional look-up table.
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Figure 46.

where:
 yis the interpolated value
* y4 and y, are the ordinate values at the beginning and end of the interpolating interval, respectively
* X4 and x, are the abscissa values at the beginning and end of the interpolating interval, respectively

» x is the input value provided to the function in the X input argument

/ Table points

Figure 47. Algorithm diagram - fractional version

The GFLIB_Lut1D function fuses a table of the precalculated function points. These points are selected with a fixed step.

The fractional version of the algorithm has a defined interval of inputs within the range <-1; 1>. The last table point is intended for
the real value of 1, not the value of 1 from the fraction numbers, which is lower than the real value of 1. The calculations are based
on the same intervals among the table points. The number of points must be 2" + 1, where n can range from 1 through to 15.

The function finds two nearest precalculated points of the input argument, and calculates the output value using the linear
interpolation between these two points.

2.15.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1).

The available versions of the GFLIB_Lut1D function are shown in the following table:
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Table 16. Function versions

Function name Input type Parameters Result type

Table Table size

GFLIB_Lut1D_F16 |frac16_t frac16_t* uint16_t frac16_t

The input arguments are the 16-bit fractional value that contains the abscissa for which the 1-D
interpolation is performed, the pointer to a table which contains the 16-bit fractional values of the look-up
table, and the size of the look-up table. The table size parameter can be in the range <1 ; 15> (that means
the parameter is log, of the number of points + 1). The output is the interpolated 16-bit fractional value
computed from the look-up table.

GFLIB_Lut1D_F32 |frac32_t frac32_t* uint16_t frac32_t

The input arguments are the 32-bit fractional value that contains the abscissa for which the 1-D
interpolation is performed, the pointer to a table which contains the 32-bit fractional values of the look-up
table, and the size of the look-up table. The table size parameter can be in the range <1 ; 15> (that means
the parameter is log, of the number of points + 1). The output is the interpolated 32-bit fractional value
computed from the look-up table.

2.15.2 Declaration

The available GFLIB_Lut1D functions have the following declarations:

fraclé_t GFLIB_LutlD Fl6(fraclé6 tfl6X, const fraclé6 t *pfl6Table, uintl6 t ul6TableSize)

2.15.3 Function use

The use of the GFLIB_Lut1D function is shown in the following examples:

Fixed-point version:
#include "gflib.h"

static fracl6 t fl6Result, f16X;

static uintl6_t ul6TableSize;

static fracl6 t fl6Table[9] = {FRAC16(0.8), FRAC16(0.1), FRAC16(-0.2), FRAC16(0.7),
FRAC16 (0.2), FRAC16(-0.3), FRAC16(-0.8), FRAC16(0.91), FRAC16(0.99)};

void main (void)

{
ul6TableSize = 3; /* size of table = 2 ~ 3 + 1 */
f16X = FRAC16(0.625); /* £16X = 0.625 */

/* flé6Result = value from look-up table between 7th and 8th position */
fl6Result = GFLIB LutlD Fl16(fl16X, fl6Table, ulé6TableSize);
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2.16 GFLIB_LutPer1D

The GFLIB_LutPer1D function approximates the one-dimensional arbitrary user function using the interpolation look-up method.
It is periodic.
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Figure 48.

where:
 yis the interpolated value
* y4 and y, are the ordinate values at the beginning and end of the interpolating interval, respectively
* X4 and x, are the abscissa values at the beginning and end of the interpolating interval, respectively

» x is the input value provided to the function in the X input argument

/ Table points

Figure 49. Algorithm diagram - fractional version

The GFLIB_LutPer1D fuses a table of the pre-calculated function points. These points are selected with a fixed step.

The fractional version of the algorithm has a defined interval of inputs within the range <-1 ; 1>. The last table point is intended
for the real value of 1 not the value of 1 from the fraction numbers, which is lower than the real value of 1. The calculations are
based on the same intervals among the table points. The floating-point version of the algorithm has a defined interval of inputs
within the range <min ; max>, where the min and max values are the parameters of the algorithms. The number of points is within
the range <2 ; 65535>, where the first point lies at the min position, and the last point lies at the max position.

The function finds two nearest precalculated points of the input argument, and calculates the output value using the linear
interpolation between these two points. This algorithm serves for periodical functions. That means that when the input argument
lies behind the last pre-calculated point of the function, the interpolation is calculated between the last and first points of the table.
2.16.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1).
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The available versions of the GFLIB_LutPer1D function are shown in the following table:

Table 17. Function versions

Function name Input type Parameters Result type

Table Table size

GFLIB_LutPer1D_F16 frac16_t frac16_t* uint16_t frac16_t

The input arguments are the 16-bit fractional value that contains the abscissa for which the 1-D
interpolation is performed, the pointer to a structure which contains the 16-bit fractional values of the
periodic look-up table, and the size of the look-up table. The table size parameter can be in the range
<1; 15> (that means the parameter is log, of the number of points). The output is the interpolated
16-bit fractional value computed from the periodic look-up table.

GFLIB_LutPer1D_F32 frac32_t frac32_t* uint16_t frac32_t

The input arguments are the 32-bit fractional value that contains the abscissa for which the 1-D
interpolation is performed, the pointer to a table which contains the 32-bit fractional values of the
periodic look-up table, and the size of the periodic look-up table. The table size parameter can be
in the range <1 ; 15> (that means the parameter is log, of the number of points). The output is the
interpolated 32-bit fractional value computed from the periodic look-up table.

2.16.2 Declaration

The available GFLIB_LutPer1D functions have the following declarations:

fracl6_t GFLIB_LutPerlD F16(fracl6_tfl6X, const fracl6_t *pfléTable, uintl6_t ul6TableSize)

2.16.3 Function use

The use of the GFLIB_LutPer1D function is shown in the following examples:

Fixed-point version:
#include "gflib.h"

static fraclé6 t fl6Result, f16X;

static uintl6 t ulé6TableSize;

static fracl6 t fl6Table[8] = {FRAC16(0.8), FRAC16(0.1), FRAC16(-0.2), FRAC16(0.7),
FRAC16(0.2), FRAC16(-0.3), FRAC16(-0.8), FRAC16(0.91)};

void main (void)

{
ul6TableSize = 3; /* size of table = 2 ~ 3 */
f16X = FRAC16(0.25); /* £f16X = 0.25 */

/* fl6Result = value from periodic look-up table at 6th position */
fl6Result = GFLIB LutPerlD F16(fl6X, fl6Table, ulé6TableSize);
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217 GFLIB_Ramp

The GFLIB_Ramp function calculates the up / down ramp with the defined fixed-step increment / decrement. These two
parameters must be set by the user.
For a proper use, it is recommended that the algorithm is initialized by the GFLIB_Ramplnit function, before using the

GFLIB_Ramp function. The GFLIB_Ramplnit function initializes the internal state variable of the GFLIB_Ramp algorithm with a
defined value. You must call the init function when you want the ramp to be initialized.

The use of the GFLIB_Ramp function is as follows: If the target value is greater than the ramp state value, the function adds the
ramp-up value to the state output value. The output will not trespass the target value, that means it will stop at the target value.
If the target value is lower than the state value, the function subtracts the ramp-down value from the state value. The output is

limited to the target value, that means it will stop at the target value. This function returns the actual ramp output value. As time

passes, it is approaching the target value by step increments defined in the algorithm parameters' structure. The functionality of
the implemented ramp algorithm is explained in the next figure:
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Figure 50. GFLIB_Ramp functionality
2.17.1 Available versions

This function is available in the following versions:
» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the GFLIB_Ramplnit functions are shown in the following table:
Table 18. Init function versions

Function name Input Parameters Result Description
type type
GFLIB_Ramplnit_F16 |frac16_t | GFLIB_RAMP_T_F16* |void

Input argument is a 16-bit fractional value that
represents the initialization value. The parameters'

structure is pointed to by a pointer. The input data
value is in the range <-1; 1).

Table continues on the next page...

GFLIB User's Guide, Rev. 5, 01 November 2021
User Guide

48/106



NXP Semiconductors

Algorithms in detail

Table 18. Init function versions (continued)

Function name Input Parameters Result Description
type type
GFLIB_Ramplnit_F32 |frac32_t | GFLIB_RAMP_T_F32* |void Input argument is a 32-bit fractional value that

represents the initialization value. The parameters'
structure is pointed to by a pointer. The input data
value is in the range <-1; 1).

The available versions of the GFLIB_Ramp functions are shown in the following table:

Table 19. Function versions

Function name Input Parameters Result Description
type type

GFLIB_Ramp_F16 |frac16_t |GFLIB_RAMP_T_F16* |frac16_t |Input argumentis a 16-bit fractional value that
represents the target output value. The parameters'
structure is pointed to by a pointer. The function returns
a 16-bit fractional value, which represents the actual
ramp output value. The input data value is in the range
<-1; 1), and the output data value is in the range <-1; 1).

GFLIB_Ramp_F32 |frac32_t | GFLIB_RAMP_T_F32* |frac32_t |Input argumentis a 32-bit fractional value that
represents the target output value. The parameters'
structure is pointed to by a pointer. The function returns
a 32-bit fractional value, which represents the actual
ramp output value. The input data value is in the range
<-1;1), and the output data value is in the range <-1; 1).

2.17.2 GFLIB_RAMP_T_F16

Variable name Type Description
f16State frac16_t | Actual value - controlled by the algorithm.
f16RampUp frac16_t | Value of the ramp-up increment. The data value is in the range <0 ; 1). Set by the user.
f16RampDown frac16_t | Value of the ramp-down increment. The data value is in the range <0 ; 1). Set by the user.

2.17.3 GFLIB_RAMP_T_F32

Variable name Type Description
f32State frac32_t | Actual value - controlled by the algorithm.
f32RampUp frac32_t | Value of the ramp-up increment. The data value is in the range <0 ; 1). Set by the user.
f32RampDown frac32_t | Value of the ramp-down increment. The data value is in the range <0 ; 1). Set by the user.

GFLIB User's Guide, Rev. 5, 01 November 2021
User Guide 49 /106




NXP Semiconductors

2.17.4 Declaration

The available GFLIB_Ramplnit functions have the following declarations:

void GFLIB RampInit F16(fracl6 t fl6InitVal, GFLIB RAMP T F16 *psParam)
void GFLIB RampInit F32(frac32 t f32InitVal, GFLIB RAMP T F32 *psParam)

The available GFLIB_Ramp functions have the following declarations:
fraclé t GFLIB Ramp F16(fraclé t flé6Target, GFLIB RAMP T F16 *psParam)

frac32_t GFLIB Ramp F32(frac32 t f32Target, GFLIB RAMP T F32 *psParam)

2.17.5 Function use

The use of the GFLIB_Ramplnit and GFLIB_Ramp functions is shown in the following examples:

Algorithms in detail

Fixed-point version:
#include "gflib.h"

static fraclé t fl6InitVal;
static GFLIB RAMP T F16 sParam;
static fraclé6 t flé6Target, fl6Result;

void Isr (void) ;

void main (void)

{
sParam.fl6RampUp = FRAC16(0.1);
sParam.fl6RampDown = FRAC16(0.02);
fl6Target = FRAC16(0.75);
fl6InitVal = FRAC16(0.9);
GFLIB RampInit F16(fl16InitVal, &sParam);

/* periodically called function */
void Isr ()
{
fl6Result = GFLIB Ramp F16 (fl6Target, &sParam);

2.18 GFLIB_DRamp

The GFLIB_DRamp function calculates the up / down ramp with the defined step increment / decrement. The algorithm
approaches the target value when the stop flag is not set, and/or returns to the instant value when the stop flag is set.
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Figure 51. GFLIB_DRamp functionality

For a proper use, it is recommended that the algorithm is initialized by the GFLIB_DRamplnit function, before using the
GFLIB_DRamp function. This function initializes the internal state variable of GFLIB_DRamp algorithm with the defined value. You
must call this function when you want the ramp to be initialized.

The GFLIB_DRamp function calculates a ramp with a different set of up / down parameters, depending on the state of the stop
flag. If the stop flag is cleared, the function calculates the ramp of the actual state value towards the target value, using the up or
down increments contained in the parameters' structure. If the stop flag is set, the function calculates the ramp towards the instant
value, using the up or down saturation increments.

If the target value is greater than the state value, the function adds the ramp-up value to the state value. The output cannot be
greater than the target value (case of the stop flag being cleared), nor lower than the instant value (case of the stop flag being set).

If the target value is lower than the state value, the function subtracts the ramp-down value from the state value. The output
cannot be lower than the target value (case of the stop flag being cleared), nor greater than the instant value (case of the stop flag
being set).

If the actual internal state reaches the target value, the reach flag is set.

2.18.1 Available versions
The function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the GFLIB_DRamplnit function are shown in the following table:
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Table 20. Init function versions

Function name Input Parameters Result Description
type type
GFLIB_DRamplnit_F16 |frac16_t |GFLIB_DRAMP_T_F16* |void Input argument is a 16-bit fractional value

that represents the initialization value. The
parameters' structure is pointed to by a pointer.
The input data value is in the range <-1 ; 1).

GFLIB_DRamplnit_F32 |frac32_t |GFLIB_DRAMP_T_F32* |void Input argument is a 32-bit fractional value

that represents the initialization value. The
parameters' structure is pointed to by a pointer.
The input data value is in the range <-1 ; 1).

The available versions of the GFLIB_DRamp function are shown in the following table:

Table 21. Function versions

Function name Input type Parameters Result type
Target Instant Stop flag

GFLIB_DRamp_F1 | frac16_t frac16_t bool_t * GFLIB_DRAMP_T_F16* frac16_t

6
The target and instant arguments are 16-bit fractional values. The parameters' structure is pointed to by a
pointer. The function returns a 16-bit fractional value, which represents the actual ramp output value. The
input data values are in the range of <-1 ; 1), the Stop flag parameter is a pointer to a boolean value, and
the output data value is in the range <-1; 1).

GFLIB_DRamp_F3 | frac32_t frac32_t bool_t * GFLIB_DRAMP_T_F32* frac32_t

2

The target and instant arguments are 32-bit fractional values. The parameters' structure is pointed to by a
pointer. The function returns a 32-bit fractional value, which represents the actual ramp output value. The
input data values are in the range <-1; 1), the Stop flag parameter is a pointer to a boolean value, and the
output data value is in the range <-1; 1).

2.18.2 GFLIB_DRAMP_T_F16

Variable name Type Description

f16State frac16_t | Actual value - controlled by the algorithm.

f16RampUp frac16_t | Value of non-saturation ramp-up increment. The data value is in the range <0 ; 1). Set by the
user.

f16RampDown frac16_t | Value of non-saturation ramp-down increment. The data value is in the range <0 ; 1). Set by
the user.

f16RampUpSat frac16_t | Value of saturation ramp-up increment. The data value is in the range <0 ; 1). Set by the
user.

f16RampDownSat |frac16_t |Value of saturation ramp-down increment. The data value is in the range <0 ; 1). Set by the
user.

bReachFlag bool_t If the actual state value reaches the target value, this flag is set, otherwise, it is cleared. Set
by the algorithm.
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2.18.3 GFLIB_LDRAMP_T_F32

Variable name Type Description

f32State frac32_t | Actual value - controlled by the algorithm.

f32RampUp frac32_t | Value of non-saturation ramp-up increment. The data value is in the range <0 ; 1). Set by the
user.

f32RampDown frac32_t | Value of non-saturation ramp-down increment. The data value is in the range <0 ; 1). Set by
the user.

f32RampUpSat frac32_t | Value of saturation ramp-up increment. The data value is in the range <0 ; 1). Set by the
user.

f32RampDownSat |frac32_t |Value of saturation ramp-down increment. The data value is in the range <0 ; 1). Set by the
user.

bReachFlag bool_t If the actual state value reaches the target value, this flag is set, otherwise, it is cleared. Set
by the algorithm.

2.18.4 Declaration

The available GFLIB_DRamplnit functions have the following declarations:

void GFLIB DRampInit F16(fracl6 t fl6InitVal, GFLIB DRAMP T F16 *psParam)
void GFLIB DRampInit F32(frac32 t f32InitVal, GFLIB DRAMP T F32 *psParam)

The available GFLIB_DRamp functions have the following declarations:
fraclé t GFLIB DRamp F16(fracl6 t fl6Target, fracl6 t flé6Instant, const bool t *pbStopFlag,
GFLIB DRAMP T F16 *psParam)

frac32_t GFLIB_DRamp F32(frac32 t f32Target, frac32 t f32Instant, const bool t *pbStopFlag,
GFLIB DRAMP T F32 *psParam)

2.18.5 Function use

The use of the GFLIB_DRamplnit and GFLIB_DRamp functions is shown in the following examples:

Fixed-point version:
#include "gflib.h"

static fracl6 t fl6Initval, fl6Target, flé6Instant, flé6Result;
static GFLIB DRAMP T F16 sParam;
static bool t bStopFlag;

void Isr (void);

void main (void)

{
sParam.fl6RampUp = FRAC16(0.05);
sParam.fl6RampbDown = FRAC16(0.02);
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sParam. fl16RampUpSat = FRAC16(0.025) ;
sParam.fl6RampDownSat = FRAC16(0.01);
fl6Target = FRACL16(0.7);

fl6Initval = FRAC16(0.3);

fl6Instant = FRAC16(0.6);

bStopFlag = FALSE;

GFLIB DRampInit F16(f16InitVal, &sParam);
}

/* periodically called function */
void Isr ()

{
fl6Result = GFLIB DRamp F16 (fl6Target, flé6Instant, &bStopFlag, &sParam);

2.19 GFLIB_FlexRamp

The GFLIB_FlexRamp function calculates the up/down ramp with a fixed-step increment that is calculated according to the
required speed change per a defined duration. These parameters must be set by the user.

The GFLIB_FlexRamp algorithm consists of three functions that must be used for a proper functionality of the algorithm:
* GFLIB_FlexRamplnit - this function initializes the state variable with a defined value and clears the reach flag
» GFLIB_FlexRampCalcincr - this function calculates the increment and clears the reach flag
» GFLIB_FlexRamp - this function calculates the ramp in the periodically called loop

For a proper use, it is recommended to initialize the algorithm by the GFLIB_FlexRamplnit function. The GFLIB_FlexRamplnit
function initializes the internal state variable of the algorithm with a defined value and clears the reach flag. Call the init function
when you want to initialize the ramp.

To calculate the increment, use the GFLIB_FlexRampCalcincr function. This function is called at the point when you want to
change the ramp output value. This function's inputs are the target value and duration. The target value is the destination value
that you want to get to. The duration is the time required to change the ramp output from the actual state to the target value. To be
able to calculate the ramp increment, fill the control structure with the sample time, that means the period of the loop where the
GFLIB_FlexRamp function is called. The structure also contains a variable which determines the maximum value of the increment.
It is necessary to set it up too. The equation for the increment calculation is as follows:

V=V
I= tT ST,

Figure 52.

where:
* |is the increment
* Viis the target value
» Vs is the state (actual) value (in the structure)
» Tis the duration of the ramp (to reach the target value starting at the state value)
* Tgis the sample time, that means the period of the loop where the ramp algorithm is called (set in the structure)
If the increment is greater than the maximum increment (set in the structure), the increment uses the maximum increment value.

As soon as the new increment is calculated, call the GFLIB_FlexRamp algorithm in the periodical control loop. The function works
as follows: The function adds the increment to the state value (from the previous step), which results in a new state. The new state
is returned by the function. As the time passes, the algorithm is approaching the target value. If the new state trespasses the target
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value, that new state is limited to the target value and the reach flag is set. The functionality of the implemented algorithm is shown

in this figure:

Duration

Duration
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Figure 53. GFLIB_FlexRamp functionality

2.19.1 Available versions

This function is available in the following versions:
» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1). The input parameters
are the fractional and accumulator types.

The available versions of the GFLIB_FlexRamplnit function are shown in the following table:

Table 22. Init function versions

Function name Input Parameters Result Description

type type
GFLIB_FLEXRAMP_T_F32* void The input argument is a 16-bit fractional
value that represents the initialization
value. The parameters' structure is
pointed to by a pointer. The input data
value is in the range <-1; 1).

GFLIB_FlexRamplnit_F16 frac16_t

The available versions of the GFLIB_FlexRamp function are shown in the following table:
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Table 23. Increment calculation function versions

Function name Input type Parameters Result

type

Target Duration

GFLIB_FlexRampCalcincr_F16 frac16_t acc32_t GFLIB_FLEXRAMP_T_F32* void

The input arguments are a 16-bit fractional value in the range <-1; 1) that represents
the target output value and a 32-bit accumulator value in the range (0 ; 65536.0)

that represents the duration of the ramp (in seconds) to reach the target value. The
parameters' structure is pointed to by a pointer.

Table 24. Function versions

Function name Parameters Result Description
type

GFLIB_FlexRamp_F16 GFLIB_FLEXRAMP_T_F32* frac16_t | The parameters' structure is pointed to by a pointer.
The function returns a 16-bit fractional value, which
represents the actual ramp output value. The output
data value is in the range <-1; 1).

2.19.2 GFLIB_FLEXRAMP_T_F32

Variable name Type Description

f32State frac32_t | The actual value. Controlled by the GFLIB_FlexRamplnit_F16 and GFLIB_FlexRamp_F16
algorithms.

f32Incr frac32_t | The value of the flex ramp increment. Controlled by the GFLIB_FlexRampCalclncr_F16
algorithm.

f32Target frac32_t | The target value of the flex ramp algorithm. Controlled by the GFLIB_FlexRampCalclncr_F16
algorithm.

f32Ts frac32_t | The sample time, that means the period of the loop where the GFLIB_FlexRamp_F16
algorithms are periodically called. The data value (in seconds) is in the range (0 ; 1). Set
by the user.

f32IncrMax frac32_t | The maximum value of the flex ramp increment. The data value is in the range (0 ; 1). Set by
the user.

bReachFlag bool_t The reach flag. This flag is controlled by the GFLIB_FlexRamp_F16 algorithm. It is cleared
by the GFLIB_FlexRamplnit_F16 and GFLIB_FlexRampCalclncr_F16 algorithms.

2.19.3 Declaration

The available GFLIB_FlexRamplnit functions have the following declarations:

void GFLIB FlexRampInit F16(fracl6 t f16InitVal, GFLIB FLEXRAMP T F32 *psParam)
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The available GFLIB_FlexRampCalcIncr functions have the following declarations:

void GFLIB FlexRampCalcIncr F16(fraclée_t fléTarget, acc32_t a32Duration,

GFLIB_FLEXRAMP T F32 *psParam)

The available GFLIB_FlexRamp functions have the following declarations:

fracl6_t GFLIB_FlexRamp F16 (GFLIB_FLEXRAMP T F32 *psParam)

2.19.4 Function use

The use of the GFLIB_FlexRamplnit, GFLIB_FlexRampCalclncr, and GFLIB_FlexRamp functions is shown in the
following examples:

Fixed-point version:
#include "gflib.h"

static fraclé t fl6InitVal;

static GFLIB_FLEXRAMP T F32 sFlexRamp;
static fraclé t flé6Target, fl6RampResult;
static acc32 t a32RampDuration;

void Isr (void) ;

void main (void)

{

/* Control loop period is 0.002 s; maximum increment value is 0.15 */
sFlexRamp.f32Ts = FRAC32 (0.002) ;
sFlexRamp.f32IncrMax = FRAC32(0.15);

/* Initial value to 0 */
fl6InitVal = FRAC16(0.0);

/* Flex ramp initialization */
GFLIB FlexRampInit F16(fl16InitVal, &sFlexRamp);

/* Target value is 0.7 in duration of 5.3 s */
fl6Target = FRACL16(0.7);
a32RampDuration = ACC32(5.3);;

/* Flex ramp increment calculation */
GFLIB FlexRampCalcIncr F16(fl6Target, a32RampDuration, &sFlexRamp);

/* periodically called control loop with a period of 2 ms */
void Isr ()

{
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fl6RampResult = GFLIB FlexRamp F16 (&sFlexRamp) ;

2.20 GFLIB_DFlexRamp

The GFLIB_DFlexRamp function calculates the up/down ramp with a fixed-step increment that is calculated according to the
required speed change per a defined duration.These parameters must be set by the user. The algorithm has stop flags. If none
of them is set, the ramp behaves normally. If one of them is set, the ramp can run in the opposite direction.

The GFLIB_DFlexRamp algorithm consists of three functions that must be used for a proper functionality of the algorithm:
» GFLIB_DFlexRamplnit - this function initializes the state variable with a defined value and clears the reach flag
» GFLIB_DFlexRampCalclincr - this function calculates the increment and clears the reach flag
» GFLIB_DFlexRamp - this function calculates the ramp in the periodically called loop

For a proper use, initialize the algorithm by the GFLIB_DFlexRamplnit function. The GFLIB_DFlexRamplnit function initializes the
internal state variable of the algorithm with a defined value and clears the reach flag. Call the init function when you want to initialize
the ramp.

To calculate the increment, use the GFLIB_DFlexRampCalcincr function. Call this function when you want to change the ramp
output value. This function's inputs are the target value and duration, and the ramp increments for motoring and generating
saturation modes. The target value is the destination value that you want to get to. The duration is the time required to change
the ramp output from the actual state to the target value. To calculate the ramp increment, fill the control structure with the sample
time, that means the period of the loop where the GFLIB_DFlexRamp funciton is called. The structure also contains a variable
which determines the maximum value of the increment. It is necessary to set it up too. The equation for the increment calculation
is as follows:

Figure 54.

where:

* |is the increment

» Viis the target value

» V; is the state (actual) value (in the structure)

» Tis the duration of the ramp (to reach the target value starting at the state value)

* T is the sample time, that means the period of the loop where the ramp algorithm is called (set in the structure)
If the increment is greater than the maximum increment (set in the structure), the increment uses the maximum increment value.
The state, target, and instant values must have the same sign, otherwise the saturation modes don't work properly.

As soon as the new increment is calculated, you can call the GFLIB_DFlexRamp algorithm in the periodical control loop. If none
of the stop flags is set, the function works as follows: The function adds the increment to the state value (from the previous step),
which results in a new state. The new state is returned by the function. As time passes, the algorithm is approaching the target
value. If the new state trespasses the target value that new state is limited to, the target value and the reach flag are set. The
functionality of the implemented algorithm is shown in the following figure:
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Figure 55. GFLIB_DFlexRamp functionality

If the motoring mode stop flag is set and the absolute value of the target value is greater than the absolute value of the state value,
the function uses the increment for the motoring saturation mode to return to the instant value. Use case: when the application is
in the saturation mode and cannot supply more power to increase the speed, then a saturation (motoring mode) flag is generated.
To get out of the saturation, the ramp output value is being reduced.

If the generating mode stop flag is set and the absolute value of the target value is lower than the absolute value of the state value,
the funcion uses the increment for the generating saturation mode to return to the instant value. Use case: when the application is
braking a motor and voltage increases on the DC-bus capacitor, then a saturation (generating mode) flag is generated. To avoid
trespassing the DC-bus safe voltage limit, the speed requirement is increasing to disipate the energy of the capacitor.

2.20.1 Awvailable versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1). The input parameters
are the fractional and accumulator types.

The available versions of the GFLIB_DFlexRamplnit functions are shown in the following table:

Table 25. Init function versions

Function name Input Parameters Result Description
type type
GFLIB_FlexRamplnit_F16 frac16_t | GFLIB_DFLEXRAMP_T_F32* |void The input argument is a 16-bit fractional

value that represents the initialization
value. The parameters' structure is
pointed to by a pointer. The input data
value is in the range <-1; 1).

The available versions of the GFLIB_DFlexRamp functions are shown in the following table:
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Table 26. Increment calculation function versions

Function name

Input type Parameters Result
type

Target Duration | Incr. sat- | Incr. sat-
mot gen

GFLIB_DFlexRampCalcincr_F16 frac16_t |acc32_t frac32_t |frac32_t | GFLIB_DFLEXRAMP_T_F32* |void

The input arguments are 16-bit fractional values in the range <-1 ; 1) that represent

the target output value and a 32-bit accumulator value in the range (0 ; 65536.0) that
represents the duration (in seconds) of the ramp to reach the target value. The other two
arguments are increments for the saturation mode when in the motoring and generating
modes. The parameters' structure is pointed to by a pointer.

Table 27. Function versions

Function name Input type Parameters Result
e
Instant | Stop flag- | Stop flag- typ
mot gen
GFLIB_DFlexRamp_F16 frac16_t | bool_t* bool_t* GFLIB_DFLEXRAMP_T_F32* frac16_t

The input argument is a 16-bit fractional value in the range <-1 ; 1) that represents the
measured instant value. The stop flags are pointers to the bool_t types. The parameters'
structure is pointed to by a pointer. The function returns a 16-bit fractional value, which
represents the actual ramp output value. The output data value is in the range <-1; 1).

2.20.2 GFLIB_DFLEXRAMP_T_F32

Variable name Type Description

f32State frac32_t | The actual value. Controlled by the GFLIB_FlexRamplnit_F16 and GFLIB_FlexRamp_F16
algorithms.

f32Incr frac32_t | The value of the dyn. flex ramp increment. Controlled by the GFLIB_FlexRampCalcincr_F16
algorithm.

f32IncrSatMot frac32_t | The value of the dyn. flex ramp increment when in the motoring saturation mode. Controlled
by the GFLIB_DFlexRampCalcincr_F16 algorithm.

f32IncrSatGen frac32_t | The value of the dyn. flex ramp increment when in the generating saturation mode.
Controlled by the GFLIB_DFlexRampCalcincr_F16 algorithm.

f32Target frac32_t | The target value of the flex ramp algorithm. Controlled by the
GFLIB_DFlexRampCalclncr_F16 algorithm.

f32Ts frac32_t | The sample time, that means the period of the loop where the GFLIB_DFlexRamp_F16
algorithm is periodically called. The data value (in seconds) is in the range (0 ; 1). Set by the
user.

f32IncrMax frac32_t | The maximum value of the flex ramp increment. The data value is in the range (0 ; 1). Set by
the user.

bReachFlag bool_t Reach flag. This flag is controlled by the GFLIB_DFlexRamp_F16 algorithm. It is cleared by
the GFLIB_DFlexRamplnit_F16 and GFLIB_DFlexRampCalclncr_F16 algorithms.
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2.20.3 Declaration

The available GFLIB_DFlexRamplnit functions have the following declarations:
void GFLIB DFlexRampInit F16 (fracl6 t f16InitVal, GFLIB DFLEXRAMP T F32 *psParam)

The available GFLIB_DFlexRampCalcincr functions have the following declarations:

void GFLIB DFlexRampCalcIncr F16(fracl6 t flé6Target, acc32 t a32Duration, frac32 t f32IncrSatMot,
frac32 t £32IncrSatGen, GFLIB DFLEXRAMP T F32 *psParam)

The available GFLIB_DFlexRamp functions have the following declarations:

fraclé t GFLIB DFlexRamp F16 (fracl6 t flé6Instant, const bool t *pbStopFlagMot, const bool t
*pbStopFlagGen, GFLIB_DFLEXRAMP T _F32 *psParam)

2.20.4 Function use

The use of the GFLIB_DFlexRamplnit, GFLIB_DFlexRampCalcincr, and GFLIB_DFlexRamp functions is shown in the
following examples:

Fixed-point version:
#include "gflib.h"

static fracl6_t fl6InitVal;

static GFLIB_DFLEXRAMP T F32 sDFlexRamp;

static fracl6 t flé6Target, fl6RampResult, flé6Instant;
static acc32 t a32RampDuration;

static frac32 t f32IncrSatMotMode, f32IncrSatGenMode;
static bool t bSatMot, bSatGen;

void Isr(void) ;

void main (void)

{
/* Control loop period is 0.002 s; maximum increment value is 0.15 */
sDFlexRamp.f32Ts = FRAC32(0.002);
sDFlexRamp.f32IncrMax = FRAC32 (0.15);

/* Initial value to 0 */
fl6InitVal = FRAC16(0.0);

/* Dyn. flex ramp initialization */
GFLIB FlexRampInit F16(f16InitVal, &sDFlexRamp) ;

/* Target value is 0.7 in duration of 5.3 s */
fl6Target = FRACL16(0.7);

a32RampDuration = ACC32(5.3);;

/* Saturation increments */
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f32IncrSatMotMode = FRAC32(0.000015) ;
f32IncrSatGenMode = FRAC32(0.00002) ;

/* Saturation flags init */
bSatMot = FALSE;
bSatGen = FALSE;

/* Dyn. flex ramp increment calculation */

GFLIB DFlexRampCalcIncr F16 (fl6Target, a32RampDuration, f32IncrSatMotMode,
f32IncrSatGenMode, &sDFlexRamp) ;
}

/* periodically called control loop with a period of 2 ms */
void Isr()
{
fl6RampResult = GFLIB DFlexRamp F16(fl6Instant, &bSatMot, &bSatGen, &sDFlexRamp);

2.21 GFLIB_FlexSRamp

The GFLIB_FlexSRamp function calculates the up/down ramp with a variable increment that is calculated according to the
required speed change per a defined duration. These parameters must be set by the user. The variable increment is profiled to
reach the S-profile of the resulting ramp.

The GFLIB_FlexSRamp algorithm consists of three functions that must be used for a proper functionality of the algorithm:

» GFLIB_FlexSRamplnit - this function initializes the state variable with a defined value, resets the accelaration increment to
zero, sets the acceleration state to zero, and clears the reach flag

» GFLIB_FlexSRampCalclincr - this function calculates the desired acceleraion, two points of the speed where the
acceleration changes from a variable to a constant and vice-versa, acceleration (derivative) increment, resets the
increment to zero, sets the acceleration state to zero, and clears the reach flag

» GFLIB_FlexSRamp - this function calculates the ramp in the periodically called loop

For a proper use, initialize the algorithm by the GFLIB_FlexSRamplnit function. The GFLIB_FlexSRamplnit function initializes the
internal state variable of the algorithm with a defined value, resets the acceleration increment to zero, sets the acceleration state
to zero, and clears the reach flag. This function does not affect the other parameters of the ramp. Call the init function to initialize
the ramp.

To calculate the profile of the ramp, use the GFLIB_FlexSRampCalclncr function. This function is called when you want to change
the ramp output value. This function's inputs are the target value and duration. The target value is the destination value that you
want to get to. The duration is the time required to change the ramp output from the actual state to the target value. To calculate
the ramp increment, fill the control structure with the sample time, that means the period of the loop where the GFLIB_FlexSRamp
function is called. Set up the desirable acceleration derivative that is necessary for the acceleration and decceleration states. The
structure also contains a variable that determines the maximum value of the increment (acceleration). It is necessary to set it up
too. The equations for the ramp calculation are derived from the following figure:
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Figure 56. GFLIB_FlexSRamp profile

For the ramp output change in each state, these equations apply:

v, =X(T) = x(0)

Figure 57.
Axy =x(T) = x(T)
Figure 58.
Axy= Ax;
Figure 59.
where:

» x is the ramp output

* Ax4 is the ramp change in state 0

» Ax5 is the ramp change in state 1

» Axjz is the ramp change in state 2

» T4 is the instant when the desired acceleration is reached and becomes constant
* T, is the instant when the desired acceleration starts to decrease

To get the full ramp change between the actual state value and the target value, this equation applies:
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Ax = Ax )+ Axy+ Axy =2« Ax+ Ax,

Figure 60.

The value of the desired accelelarion that is reached by the integration of the acceleration derivative along the time within state O is:

Ty
Ages=a(T)) = IdA'dt=dA-T1
0

Figure 61.

where:
* ages is the desired acceleration
« dA is the derivative of the acceleration

Similarly, the Ax; and Ax, values are given by integrating the acceleration in time:

Ty

v, = IdA-rdt: Tdar?
0

Figure 62.
Ty
Axy= JAades'dt =dge(Ty— T
T
Figure 63.

Because the ramp is symetrical, time 7,is expressed as:

T2= T—- Tl
Figure 64.

where:
» Tis the duration of the ramp

Using the equations for a,es and 7,, Equation 7 is rewritten as:

Axy=dA-T (T - 2T}

Figure 65.

Putting Equation 9 and Equation 9 into Equation 4, the following equation is reached:

Mx=2%dA TP+dA T (T -2T)=~dA TP +dA T T

Figure 66.

Having normalized the previous equation, a quadrature equation is reached:

TP-T-T+4& =0

Figure 67.

GFLIB User's Guide, Rev. 5, 01 November 2021

User Guide

64/106



NXP Semiconductors

Algorithms in detail

One root of this quadrature equation is 7.

_T—\/T2—4-j—f1

T,= 5

Figure 68.

Using Equation 5, the desired acceleration is expressed as:

AT~ \dA T2~ 4-dA Ax

Ades = 2

Figure 69.

This equation has a solution within the range of real numbers only if the square root argument is not negative, so this condition
must be met:

dA-T*>4-dA- Ax

Figure 70.

If this condition is met and the desired acceleration is not greater than the maximum increment (set in the structure), the ramp
is achievable within the defined duration and the function's output flag is 7RUE. If the acceleration is greater than the maximum
increment, the function uses the maximum increment value and then the ramp is not achieved on time, the output flag is FALSE.

If the condition given by Equation 5 is not met, the ramp is not achievable within the defined duration and the function returns the
flag FALSE. In such case, the ramp skips state 1 (where the acceleration is constant) and goes directly from state 0 to state 2.
The following figure shows the ramp profile:
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Figure 71. GFLIB_FlexSRamp delayed profile
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This ramp takes longer time than desirable duration. In this case, Ax;is exactly a half of the full ramp change output. The 7;instant
is derived from Equation 6 as:

|2 dxy Ax
T =\~71 Vi

Figure 72.

The desired acceleration is given by Equation 5 as:

g = A2 = \[Ax-da

Figure 73.

Similarly to the previous case (when the ramp is achievable within the desired time), the desired acceleration cannot be greater
than the maximum increment, otherwise the function uses the maximum increment value. If the desired acceleration is trimmed,
the ramp is in state 1 with a constant acceleration.

In both cases, the desired acceleration could have been reduced to the maximum increment value, therefore it is necessary to
adjust the 7, value using Equation 5:

_ Ades

=4

Figure 74.

where:
* ages Can be changed to the maximum increment

By putting 7;into Equation 6, the Ax; value is given as:

_1 Des 2_1 ades2
Ay =2dACqp) =374

Figure 75.

Because the ramp output profile is now symetrical, the ramp output value in time 77is given by adding (or subracting) the Ax;value
to the state value. Similarly, the ramp output value in time 7,is given by subtracting (or adding) the Ax;value from the target value.
These two values are returned within the function structure together with the desired acceleration value.

Another parameter that must be calculated is the acceleration increment. The increment uses the derivative of acceleration dA
and the sample time of the application. This must apply:

_ @ _ d_zx ~ Aincr
d4="4; = ar =72
Figure 76.
where:
* Ajcr is the acceleration increment
* Tsis the sample time
The acceleration increment needed for the algorithm is:
Aincr = TSZ'dA

Figure 77.
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As soon as the necessary parameters are calculated, call the GFLIB_FlexSRamp algorithm in the periodical control loop. The
function works in these three states:

« State 0 - acceleration rises from 0 towards the desired acceleration
» State 1 - acceleration is constant
 State 2 - acceleration is falling from the desired acceleration towards zero

In state 0, the function adds the acceleration increment to the increment. In the first step, it only adds half of the acceleration
increment (to form the trapezoidal integration). The resulting increment is added to or subtracted from the state value (from the
previous step), which results in a new state. The new state is returned by the function. After the X(7,)value is reached, the function
switches to state 1. At the same time, the function checks whether the condition X{(7,) value is reached. In such case, the function
goes directly to state 2.

In state 1, the function does not change the increment; it stays constant from the last value in state 0. The increment is added to
or subtracted from the state value (from the previous step), which results in a new state. The new state is returned by the function.
When the X{(T7) value is reached, the function switches to state 2.

In state 2, the function subtracts the acceleration increment from the increment. The resulting increment is added to or subtracted
from the state value (from the previous step), which results in a new state. The new state is returned by the function. If the new
state trespasses the target value, it is trimmed to the target value. It can happen that the function output does not reach the target
value before the increment returns to zero. If the increment is zero before reaching the target value, the output stops before the
target value. This can happen because the function does not work with the continuous time. The incrementation depends on the
sampling time and the arithmetic accuracy used. To ensure that the function always reaches the target value, the function checks if
the increment is not lower than the half of the acceleration increment. If the resulting increment is lower than half of the acceleration
increment, the increment is set to a half of the acceleration increment. Using this approach, the function always reaches the target
value. As soon as the target value is reached, the reach flag is set.

The functionality of the implemented algorithm is shown in this figure:
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Figure 78. GFLIB_FlexSRamp functionality

2.21.1 Available versions

This function is available in the following versions:
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» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The input parameters
are the fractional and accumulator types.

The available versions of the GFLIB_FlexSRamplnit function are shown in the following table:

Table 28. Init function versions

Function name Input Parameters Result Description
type type

GFLIB_FlexSRamplnit_F16 |frac16_t | GFLIB_FLEXSRAMP_T_F32* |void The input argument is a 16-bit fractional
value that represents the initialization
value. The parameters' structure is
pointed to by a pointer. The input data
value is in the range <-1; 1).

The available versions of the GFLIB_FlexSRamp function are shown in the following table:

Table 29. Increment calculation function versions

Function name Input type Parameters Result

type

Target Duration

GFLIB_FlexSRampCalcincr_F16 frac16_t acc32_t GFLIB_FLEXSRAMP_T_F32 * bool_t

The input arguments are a 16-bit fractional value in the range <-1 ; 1) that represents
the target output value and a 32-bit accumulator value in the range (0 ; 1/ f16DA)

that represents the duration of the ramp (in seconds) to reach the target value. The
parameters' structure is pointed to by a pointer. The function returns TRUE if the ramp
is achievable within the defined duration; if it is not achievable, it returns FALSE. The
parameters are calculated, but the ramp takes longer.

Table 30. Function versions

Function name Parameters Result Description
type
GFLIB_FlexSRamp_F16 GFLIB_FLEXSRAMP_T_F32 * |frac16_t | The parameters'structure is pointed to by a pointer.
The function returns a 16-bit fractional value, which

represents the actual ramp output value. The output
data value is in the range <-1; 1).

2.21.2 GFLIB_FLEXSRAMP_T_F32

Variable name Type Description

f32State frac32_t | The actual value. Controlled by the GFLIB_FlexSRamplnit_F16 and GFLIB_FlexSRamp_F16
algorithms.

f32Incr frac32_t | The value of the flex s-ramp increment. Controlled by the GFLIB_FlexSRamp_F16 algorithm.
It is reset to zero by the GFLIB_FlexSRamplnit_F16 and GFLIB_FlexSRampCalcincr_F16
algorithms.

f32AIncr frac32_t | The value of the flex s-ramp acceleration increment. Controlled by the
GFLIB_FlexSRampCalcIncr_F16 algorithm.

Table continues on the next page...
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Variable name Type Description

f32ADes frac32_t | The value of the flex s-ramp desired acceleration. Controlled by the
GFLIB_FlexSRampCalcIncr_F16 algorithm.

f32Target frac32_t | The target value of the flex s-ramp algorithm. Controlled by the
GFLIB_FlexSRampCalcIncr_F16 algorithm.

f32Ts frac32_t | The sample time, that means the period of the loop where the GFLIB_FlexSRamp_F16
algorithms are periodically called. The data value (in seconds) is in the range (0 ; 1). Set by
the user.

f32IncrMax frac32_t | The maximum value of the flex s-ramp increment. The data value is in the range (0 ; 1). Set
by the user.

f32XT1 frac32_t | The flex s-ramp value of the point where the increment must stop incrementing. Controlled

by the GFLIB_FlexSRampCalcincr_F16 algorithm.

f32XT2 frac32_t | The flex s-ramp value of the point where the increment must start decrementing. Controlled
by the GFLIB_FlexSRampCalcIncr_F 16 algorithm.

f16DA frac16_t | The acceleration derivative. The data value (in accelaration change per second or ramp
output value change per square second) is in the range <0 ; 0.5). Set by the user.

u16AccState uint_16_t | The acceleration state of the function: 0 - acceleration rises; 1 - acceleration is constant; 2 -
acceleration falls. Controlled by the GFLIB_FlexSRamp_F16 algorithm. It is reset to zero by
the GFLIB_FlexSRamplnit_F16 and GFLIB_FlexSRampCalcincr_F16 algorithms.

bReachFlag bool_t Reach flag. This flag is controlled by the GFLIB_FlexSRamp_F16 algorithm. It is cleared by
the GFLIB_FlexSRamplnit_F16 and GFLIB_FlexSRampCalcincr_F16 algorithms.

2.21.3 Declaration

The available GFLIB_FlexSRamplnit functions have the following declarations:
void GFLIB FlexSRampInit F16 (fracl6 t f16InitVal, GFLIB FLEXSRAMP T F32 *psParam)

The available GFLIB_FlexSRampCalcincr functions have the following declarations:

bool t GFLIB FlexSRampCalcIncr F16(fracl6 t flé6Target, acc32 t a32Duration,
GFLIB FLEXSRAMP T F32 *psParam)

The available GFLIB_FlexSRamp functions have the following declarations:

fraclé t GFLIB FlexSRamp F16(GFLIB FLEXSRAMP T F32 *psParam)

2.21.4 Function use

The use of the GFLIB_FlexSRamplnit, GFLIB_FlexRampSCalcincr, and GFLIB_FlexSRamp functions is shown in the
following examples:
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Aramp with a profile as in Figure 56 is generated. The ramp must change the speed from 100 RPM to 900 RPM in 20 s. The speed
scale is 5000 RPM. The ramp must change the speed in 20 s. The acceleration derivative is 15 RPM / s2. The sample time is 0.1
s. The maximum acceleraion is 50 RPM / s.

Fixed-point version:

#include "gflib.h"

static fracl6 t fl6InitVal;

static GFLIB_ FLEXSRAMP T F32 sFlexSRamp;
static fraclé t flé6Target, fl6RampResult;
static acc32 t a32RampDuration;

static bool t bFlexSRampFlag;

void Isr (void) ;

void main (void)

{

/* Control loop period is 0.1 s */
sFlexSRamp.f32Ts = FRAC32(0.1);

/* Maximum increment value is 50 RPM / s */
sFlexSRamp.f32IncrMax = FRAC32(50.0 / 5000.0 * 0.1);

/* Desired acceleration derivative 15 RPM / s ~ 2 */
sFlexSRamp.f16DA = FRAC16(15.0 / 5000.0);

/* Initial value to 100 RPM */
fl6InitvVal = FRAC16(100.0 / 5000.0);

/* Flex ramp initialization */
GFLIB FlexSRampInit F16(f16InitVal, &sFlexSRamp) ;

/* Target value is 900 RPM in duration of 20 s */
fl6Target = FRAC16(900.0 / 5000.0);

a32RampDuration = ACC32(20.0);

/* Flex s-ramp parameters calculation */

bFlexSRampFlag = GFLIB FlexSRampCalcIncr Fl6 (fl6Target,

&sFlexSRamp) ;

}

/* periodically called control loop with a period of 100 ms */

void Isr ()

{

fl6RampResult = GFLIB FlexSRamp F16 (&sFlexSRamp) ;

a32RampDuration,

2.22 GFLIB_Integrator

The GFLIB_Integrator function calculates a discrete implementation of the integrator (sum), discretized using a trapezoidal rule

in Tustin's method (bi-linear transformation).

The continuous time domain representation of the integrator is defined as follows:
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)= [eton

Figure 79.

In a continuous time domain, the transfer function for this integrator is described using the Laplace transformation as follows:

U
o= 99

Figure 80.

Transforming the above equation into a digital time domain using the bi-linear transformation leads to the following
transfer function:

U@) Ts+Tez!
O

Figure 81.

where Ty is the sampling period of the system. The discrete implementation of the digital transfer function in the above equation
is expressed as follows:

(k) = u(k — 1)+e(k)% +e(k — 1)%

Figure 82.

Considering integrator gain K|, the transfer function leads to the following equation:

KT KT,
ufk)=uk — D)+ elk)—5

2+ ek — ——

Figure 83.

where:
» u(k) is the integrator's output in the actual step
» uy(k - 1) is the integrator's output from the previous step
» e(k) is the integrator's input in the actual step
» e(k - 1) is the integrator's input from the previous step
» K is the integrator's gain coefficient
* Tgis the sampling period of the system

Equation 5 can be used in the fractional arithmetic as follows:

esa(k) + esc(k — 1)
=e—=t——e

u[sc(k)' Umax = u]sc(k = D than+ K Ts ‘max

Figure 84.

where:
* Umayx is the integrator output scale
* uisc(K) is the scaled integrator output in the actual step
* Usc(k - 1) is the scaled integrator output from the previous step

* emax is the integrator input scale
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* egc(K) is the scaled integrator input in the actual step
* egc(k - 1) is the scaled integrator input in the previous step
For a proper use of this function, it is recommended to initialize the function's data by the GFLIB_Integratorlnit functions, before
using the GFLIB_Integrator function. You must call the init function when you want the integrator to be initialized.
2.22.1 Available versions
This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result, the result is within the range <-1; 1), and it may overflow
from one limit to the other. The parameters use the accumulator types.

The available versions of the GFLIB_Integratorinit function are shown in the following table:

Table 31. Init function versions

Function name Input Parameters Result Description
type type
GFLIB_Integratorlnit_ F16 |frac16_t | GFLIB_INTEGRATOR_T_A32* |void The inputs are a 16-bit fractional initial

value and a pointer to the integrator
parameters' structure.

The available versions of the GFLIB_Integrator function are shown in the following table:

Table 32. Function versions

Function name Input Parameters Result Description

type type

GFLIB_Integrator_F16 |frac16_t |GFLIB_INTEGRATOR_T_A32* |frac16_t | The inputs are a 16-bit fractional value to
be integrated and a pointer to the integrator
parameters' structure. The output is limited
to range <-1; 1>. When the integrator
reaches the limit, it overflows to the

other limit.
2.22.2 GFLIB_INTEGRATOR_T_A32
Variable name Input Description
type
a32Gain acc32_t |Integrator gain is set up according to Equation 6 as follows:
K Ty

The parameter is a 32-bit accumulator type within the range <-65536.0 ; 65536.0). Set by the

user.
f321AccK_1 frac32_t | Integral portion in the step k - 1. Controlled by the algorithm.
f16InValK_1 frac16_t | Input value in the step k - 1. Controlled by the algorithm.

2.22.3 Declaration

The available GFLIB_Integratorlnit functions have the following declarations:

void GFLIB IntegratorInit F16(fracl6 t f16InitVal, GFLIB INTEGRATOR T A32 *psParam)
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The available GFLIB_Integrator functions have the following declarations:

fraclé t GFLIB Integrator F16(fracl6 t f16InVal, GFLIB INTEGRATOR T A32 *psParam)

2.22.4 Function use

The use of the GFLIB_Integratorinit and GFLIB_Integrator functions is shown in the following examples:

Fixed-point version:
#include "gflib.h"

static fraclé t fl6Result, fl6InVal, fl6InitVal;
static GFLIBilNTEGRATOR7T7A32 sParam;

void Isr (void) ;

void main (void)

{
f16InvVal = FRAC16(-0.4);
sParam.a32Gain = ACC32(0.1);

fl16Initval = FRAC16(0.1);

GFLIB IntegratorInit F16(fl16InitVal, &sParam);
}

/* periodically called function */
void Isr ()

{
fl6Result = GFLIB Integrator F16(f16InVal, &sParam);

2.23 GFLIB_CtriBetalPpAW

The GFLIB_CtrIBetalPpAW function calculates the parallel form of the Beta-Integral-Proportional (Beta-IP) controller with an
implemented integral anti-windup functionality. The Beta-IP controller is an extended PI controller, which enables to separate
the responses from the setpoint change and the load change (if B = 1, the Beta-IP controller has the same response as the

PI controller). Therefore the Beta-IP controller allows for reducing the overshoot caused by the change of the setpoint without
affecting the load change response. The B parameter can be set in the range from zero to one, where zero means the maximal
overshoot limitation and one means no limitation.

The Beta-IP controller attempts to correct the error between the measured process variable (feedback) and the desired set-point
by calculating a corrective action that can adjust the process accordingly. The GFLIB_CtrIBetalPpAW function calculates the
Beta-IP algorithm according to the equations below. The Beta-IP algorithm is implemented in the parallel (non-interacting) form,
enabling you to define the P, |, and 3 parameters independently and without interaction. The controller output is limited and the
limit values (the upper limit and the lower limit) are defined by the user.

The Beta-IP controller algorithm also returns a limitation flag, which indicates that the controller's output is at the limit. If the Beta-IP
controller output reaches the upper or lower limits, the limit flag is set to one. Otherwise, it is zero (integer values).

An anti-windup strategy is implemented by limiting the integral portion. The integral state is limited by the controller limits in the
same way as the controller output. The integration can be stopped by a flag that is pointed to by the function's API.

The Beta-IP algorithm in the continuous time domain can be expressed as follows:
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u(t) =Kp-[f-w(1) -y(t)]”(/J.[W(f) -y(1)]-dt

Figure 85.

where:
* u(t) is the controller output in the continuous time domain
» w(t) is the required value in the continuous time domain
* y(t) is the measured value (feedback) in the continuous time domain
» Kp is the proportional gain
» K, is the integral gain
* B is the beta gain (overshoot reduction gain in the range from zero to one)

Equation 1 can be expressed using the Laplace transformation as follows:

U(s) =Kp [B- T (s)-¥(5) ] +K; -2 TE)

Figure 86.

The proportional part (up) of Equation 1 is transformed into the discrete time domain as follows:

up(k) =Kp-[f-w(k)-y(k)]

Figure 87.

where:
 up(k) is the proportional action in the actual step
» w(k) is the required value in the actual step
* y(k) is the measured value in the actual step
» Kp is the proportional gain coefficient
» Bis the beta gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

Upge (k) * thpax = Kp* [ﬁ'wsc(k) 'ysc(k)] " Cmax

Figure 88.

where:
* Umax is the action output scale
* upgc(K) is the scaled proportional action in the actual step
* emax is the error input scale
* wgc(K) is the scale required value in the actual step
* ysc(k) is the scale measured value in the actual step

Transforming the integral part (u;) of Equation 1 into a discrete time domain using the bi-linear method (also known as the
trapezoidal approximation) is as follows:
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KT, KT,
2

up(k) =up(k-1) + [w(k)-y(k)]- te(k-1)—3

Figure 89.

where:
» u(k) is the integral action in the actual step
* ui(k - 1) is the integral action from the previous step
» w(k) is the required value in the actual step
* y(k) is the measured value in the actual step
» e(k - 1) is the error in the previous step
» T is the sampling period of the system
» K, is the integral gain coefficient

Equation 5 can be used in the fractional arithmetic as follows:

e (k) +eq(k-1)
u]sc'umaX:uIsc(k' 1) 'umaerKlTs'% " €max

Figure 90.

where:
* Umayx is the action output scale
* uisc(K) is the scaled integral action in the actual step
* uisc(k - 1) is the scaled integral action from the previous step
* emax is the error input scale
* eq(K) is the scaled error in the actual step
* egc(k - 1) is the scaled error in the previous step

The output signal limitation is implemented in this controller. The actual output u(k) is bounded not to exceed the given limit values
UpperLimit and LowerLimit. This is either due to the bounded power of the actuator or due to the physical constraints of the plant.

U pperLimit u(k)> U pperLimit
u(k) ={ Lower Limit u(k) < Lower Limit
u(k) else
Figure 91.

The bounds are described by a limitation element, as shown in Equation 7. When the bounds are exceeded, the non-linear
saturation characteristic takes effect and influences the dynamic behavior. The described limitation is implemented on the
integral part accumulator (limitation during the calculation) and the overall controller output. Therefore, if the limitation occurs,
the controller output is clipped to its bounds, and the wind-up occurrence of the accumulator portion is avoided by saturating the
actual sum.

For a proper use of this function, it is recommended to initialize the function data by the GFLIB_CtrIBetalPpAWInit function, before
using the GFLIB_CtrIBetalPpAW function.
2.23.1 Available versions

This function is available in the following versions:
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 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The parameters use
the accumulator types.

The available versions of the GFLIB_CtriIBetalPpAWInit function are shown in the following table:

Table 33. Init function versions

Function name Input Parameters Result Description
type type
GFLIB_CtriBetalPpAWInit_F |frac16_t | GFLIB_CTRL_BETA_IP_P_AW_T_ | void The inputs are a 16-bit fractional
16 A32* initial value and a pointer to the
controller's parameters structure.

The available versions of the GFLIB_CtrIBetalPpAW function are shown in the following table:

Table 34. Function versions

Function name Input type Parameters Result
- type
required value| measured Stop flag yP
value
GFLIB_CtriBetalPpAW_F16 |frac16_t frac16_t bool_t * GFLIB_CTRL_BETA_IP_P_AW_T_ |frac16_t
A32*

The required value input is a 16-bit fractional value within the range <-1 ; 1). The measured value
input is a 16-bit fractional value within the range <-1; 1). The integration of the Beta-IP controller
is suspended if the stop flag is set. When it is cleared, the integration continues. The parameters
are pointed to by an input pointer. The function returns a 16-bit fractional value in the range
<f16LowerLim ; f16UpperLim>.

2.23.2 GFLIB_CTRL_BETA_IP_P_AW_T_A32

Variable name Input Description
type
a32PGain acc32_t | The proportional gain is set up according to Equation 4 as follows:
. Cmax
P Upax

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.

a32lGain acc32_t | The integral gain is set up according to Equation 6 as follows:

K,T, Cmax

Umax

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.

f321AccK_1 frac32_t | State variable of the internal accumulator (integrator). Controlled by the algorithm.
f16InErrK_1 frac16_t | Input error at the step k - 1. Controlled by the algorithm.
f16UpperLim frac16_t | Upper limit of the controller's output and the internal accumulator (integrator). This parameter

must be greater than f16LowerLim. Set by the user.

f16LowerLim frac16_t | Lower limit of the controller's output and the internal accumulator (integrator). This parameter
must be lower than f16UpperLim. Set by the user.

Table continues on the next page...
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Variable name Input Description
type
f16BetaGain frac16_t | The beta gain is a fraction 16-bit type in the range [0 ; 1). The beta gain defines the reduction
overshot when the required value is changed. Set by the user.
bLimFlag bool_t Limitation flag which identifies that the controller's output reached the limits. 1 - the limit is

reached; O - the output is within the limits. Controlled by the application.

2.23.3 Declaration
The available GFLIB_CtriIBetalPpAWInit functions have the following declarations:

void GFLIB CtrlBetaIPpAWInit F16(fracl6 t f16InitVal, GFLIB CTRL BETA IP P AW T A32 *psParam)

The available GFLIB_CtrIBetalPpAW functions have the following declarations:

fraclé t GFLIB CtrlBetalPpAW F16(fracl6 t fl6InReq,

GFLIB_CTRL BETA IP P AW T A32 *psParam)

2.23.4 Function use

The use of the GFLIB_CtrIBetalPpAWInit and GFLIB_CtrIBetalPpAW functions is shown in the following examples:

fracle t f16In, const bool t *pbStopIntegFlag,

{

sParam.
sParam.
sParam.
sParam.
sParam.
bStopIntegFlag

Fixed-point version:

#include "gflib.h"

void Isr(void) ;

void main (void)

static fracl6 t fl6Result, fl6InitVal, fl6InReq, f16In;
static bool t bStopIntegFlag;
static GFLIB CTRL BETA IP P AW T A32 sParam;

fl16InReq = FRAC16(-0.3);
fl6In

= FRAC16(-0.4);

fl6Initval =

a32PGain = ACC32(0.1);
a32IGain = ACC32(0.2);
fl6UpperLim = FRAC16(0.9
fl6LowerLim = FRAC16(-0.
fl6BetaGain = FRAC16(0.5

)i

’

)
9
)

= FALSE;

FRAC16(0.0) ;

GFLIB CtrlBetalIPpAWInit F16(fl16InitVal, &sParam);

/* periodically called function */
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void Isr ()

{
fl6Result = GFLIB CtrlBetalIPpAW F16(f16InReq, f16In, &bStopIntegFlag, &sParam);

2.24 GFLIB_CtriBetalPDpAW

The GFLIB_CtriIBetalPDpAW function calculates the parallel form of the Beta-Integral-Proportional-Derivative (Beta-IPD)
controller with the implemented integral anti-windup functionality. The Beta-IPD controller is an extended PID controller, which
enables to separate the responses from the setpoint change and the load change (if B = 1 then the Beta-IPD controller has the
same response as the PID controller). Therefore, the Beta-IPD controller enables to reduce the overshoot caused by a change
of the setpoint without affecting the load change response. The B parameter can be set in a range from zero to one, where zero
means the maximal overshoot limitation and one means no limitation.

The Beta-IPD controller attempts to correct the error between the measured process variable and the desired set-point by
calculating a corrective action that can adjust the process accordingly. The GFLIB_CtriIBetalPDpAW function calculates the
Beta-IPD algorithm according to the equations below. The Beta-IPD algorithm is implemented in the parallel (non-interacting)
form, enabling you to define the P, |, D, and 3 parameters independently and without interaction. The controller output is limited,
and the limit values (upper limit and lower limit) are defined by the user.

The algorithm has an error input for the D portion calculation. This enables you to apply different filters for the D error input and
for the required and measured value inputs.

The Beta-IPD controller algorithm also returns a limitation flag, which indicates that the controller's output is at the limit. If the
Beta-IPD controller output reaches the upper or lower limit, then the limit flag is set to one. Otherwise, it is zero (integer values).

An anti-windup strategy is implemented by limiting the integral portion. The integral state is limited by the controller limits in the
same way as the controller output. The integration can be stopped by a flag, which is pointed to by the function's API.

The Beta-IPD algorithm in the continuous time domain can be expressed as follows:

u(t) =Kpr [Bow(0) -y () 1+ K [[w() -3() ] -di+ K pthep (1)

Figure 92.

where:
* u(t) is the controller output in the continuous time domain
» w(t) is the required value in the continuous time domain
* y(t) is the measured value (feedback) in the continuous time domain
 ep(t) is the input error for the derivative calculation in the continuous time domain
* Kp is the proportional gain
» K, is the integral gain
* Kp is the derivative gain
» Bis the beta gain (overshoot reduction gain in the range from zero to one)

Equation 1 can be expressed using the Laplace transformation as follows:

W(S)S-Y(s) K

U(s) =Kp-[B-W(s)-Y(s) ]+ K, D ep"s

Figure 93.

The proportional part (up) of Equation 1 is transformed into the discrete time domain as follows:
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up(k) =Kp-[f-w(k)-y(k)]

Figure 94.

where:
 up(k) is the proportional action in the actual step
» w(k) is the required value in the actual step
* y(k) is the measured value in the actual step
» Kp is the proportional gain coefficient
* Bis the beta gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

Upge (k) * thpax = Kp- [ﬁ'wsc(k) 'ysc(k) ] * €max

Figure 95.

where:
* Umax is the action output scale
* upgc(K) is the scaled proportional action in the actual step
* €max is the error input scale
* wgc(K) is the scale required value in the actual step

* ysc(k) is the scale measured value in the actual step

Transforming the integral part (u;) of Equation 1 into a discrete time domain using the bi-linear method (also known as the

trapezoidal approximation) is as follows:

KT
re(k-1)=5=

K,T
up (k) =up(k-1)+[w(k)-y(k)]-—5

Figure 96.

where:
* uy(k) is the integral action in the actual step
» ui(k - 1) is the integral action from the previous step
» w(k) is the required value in the actual step
* y(k) is the measured value in the actual step
» e(k - 1) is the error in the previous step
» Tgis the sampling period of the system
» K is the integral gain coefficient

Equation 5 can be used in the fractional arithmetic as follows:

u, sc(k) Umax = u[sc(k =D thax + K T €max

el +edk—1)

Figure 97.

where:

* Umax is the action output scale
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* uisc(K) is the scaled integral action in the actual step

* uisc(k - 1) is the scaled integral action from the previous step
* emax is the error input scale

* eq(K) is the scaled error in the actual step

* egc(k - 1) is the scaled error in the previous step

The derivative part (up) of Equation 1 is transformed into the discrete time domain as follows:

Kp
up(k) =7 lepk)- epk-1]

Figure 98.

where:
* up(k) is the proportional action in the actual step
» ep(k) is the error used for the derivative input in the actual step
* ep(k - 1) is the error used for the derivative input in the previous step
» Kp is the proportional gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

Kp
uDsc(k) Umax = Ts : [eDsc(k) - eDsc(k D] emax

Figure 99.

where:
* Umayx is the action output scale
* Upsc(k) is the scaled derivative action in the actual step
* emax is the error input scale
* epsc(k) is the scaled error for the derivative input in the actual step
* epsc(k - 1) is the scaled error for the derivative input in the previous step

The output signal limitation is implemented in this controller. The actual output u(k) is bounded to not exceed the given limit values
- UpperLimit and LowerLimit. This is either due to the bounded power of the actuator, or due to the physical constraints of the plant.

U pperLimit u(k)> U pperLimit
u(k)={ LowerLimit u(k) < Lower Limit
u(k) else
Figure 100.

The bounds are described by a limitation element, as shown in Equation 7. When the bounds are exceeded, the non-linear
saturation characteristic takes place and influences the dynamic behavior. The described limitation is implemented in the integral
part accumulator (limitation during the calculation) and in the overall controller output. Therefore, if the limitation occurs, the
controller output is clipped to its bounds, and the wind-up occurrence of the accumulator portion is avoided by saturating the
actual sum.

For a proper use of this function, it is recommended to initialize the function data by the GFLIB_CtrIBetalPDpAWiInit functions,
before using the GFLIB_CtrIBetalPDpAW function.
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2.24.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The parameters use
the accumulator types.

The available versions of the GFLIB_CtrIBetalPDpAWInit function are shown in the following table:

Table 35. Init function versions

Function name Input Parameters Result Description
type type
GFLIB_CtriBetalPDpAWInit_F |frac16_t |GFLIB_CTRL_BETA_IPD_P_AW_ | void The inputs are a 16-bit fractional
16 T_A32* initial value and a pointer to the
controller's parameters structure.

The available versions of the GFLIB_CtriIBetalPDpAW function are shown in the following table:

Table 36. Function versions

Function name Input type Parameters Result

type

Required Measured D error Stop flag
value value

GFLIB_CtrIBetalPDpAW_F1 |frac16_t frac16_t frac16_t bool_t * GFLIB_CTRL_BETA_IPD_P_A | frac16_t
6 W_T_A32*

The required value input is a 16-bit fractional value within the range <-1; 1). The measured
value input is a 16-bit fractional value within the range <-1; 1). The D error input is a 16-bit
fractional value within the range <-1; 1). The integration of the Beta-IPD controller is suspended
if the stop flag is set. When it is cleared, the integration continues. The parameters are
pointed to by an input pointer. The function returns a 16-bit fractional value in the range
<f16LowerLim ; f16UpperLim>.

2.24.2 GFLIB_CTRL_BETA_IPD_P_AW_T_A32

Variable name Input Description
type
a32PGain acc32_t | The proportional gain is set up according to Equation 4 as follows:
€,
Kp gy

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.

a32IGain acc32_t | The integral gain is set up according to Equation 6 as follows:

KT Cmax
1

S Umax

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.

a32DGain acc32_t | The derivative gain is set up according to Equation 6 as follows:

K D . €max
T s Umax

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.

Table continues on the next page...
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Table continued from the previous page...

Variable name Input Description
type
f321AccK_1 frac32_t | State variable of the internal accumulator (integrator). Controlled by the algorithm.
f16InErrK_1 frac16_t | Input error in the step k - 1. Controlled by the algorithm.
f16UpperLim frac16_t | Upper limit of the controller's output and the internal accumulator (integrator). This parameter

must be greater than f16LowerLim. Set by the user.

f16LowerLim frac16_t | Lower limit of the controller's output and the internal accumulator (integrator). This parameter
must be lower than f16UpperLim. Set by the user.

f16InErrDK_1 frac16_t | Input error for the derivative calculation in the step k - 1. Controlled by the algorithm.

f16BetaGain frac16_t | The beta gain is a fraction 16-bit type in the range [0 ; 1). The beta gain defines the reduction
overshot when the required value is changed. Set by the user.

bLimFlag bool_t The limitation flag which identifies that the controller's output reached the limits. 1 - the limit
is reached; 0 - the output is within the limits. Controlled by the application.

2.24.3 Declaration
The available GFLIB_CtrIBetalPDpAWInit functions have the following declarations:

void GFLIB CtrlBetalPDpAWInit Fl6(fracl6_t fl6InitVal, GFLIB_CTRL_BETA IPD P AW T A32 *psParam)

The available GFLIB_CtrIBetalPDpAW functions have the following declarations:

fracl6é tGFLIB CtrlBetalIPDpAW F16 (fracl6 t fl6InReq, fracl6 t f16In, fracl6 t f16InErrD, const bool t
*pbStopIntegFlag, GFLIB CTRL BETA IPD P AW T A32 *psParam)

2.24.4 Function use
The use of the GFLIB_CtriIBetalPDpAWInit and GFLIB_CtrIBetalPDpAW functions is shown in the following examples:

Fixed-point version:
#include "gflib.h"
static fracl6 t fl6Result, fl6InitVal, fl6InReq, f16In, fl6InErrD;
static bool t bStoplIntegFlag;
static GFLIB CTRL BETA IPD P AW T A32 sParam;

void Isr (void);

void main (void)

{
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fl16InReqg = FRACL16(-0.3);

fl6In = FRAC16(-0.4);

f16InErrD = FRAC16(-0.7);

a32PGain = ACC32(0.1);
sParam.a32IGain = ACC32(0.2);
.a32DGain = ACC32(0.001);
sParam. FRAC16(0.9);
fl6LowerLim = FRAC16(-0.9);
fl6BetaGain = FRAC16(0.5);
FALSE;

sParam.

sParam
flé6UpperlLim =
sParam.
sParam.
bStopIntegFlag =

fl16Initval = FRAC16(0.0);

GFLIB CtrlBetalPDpAWInit F16(fl6InitVal, &sParam);

/* periodically called function */
void Isr ()
{

fl6Result =
&sParam) ;

}

GFLIB CtrlBetalPDpAW F16 (fl6InReq, f16In, fl6InErrD,

Algorithms in detail

&bStopIntegFlag,

2.25 GFLIB_CtrIPIpAW

The GFLIB_CtrIPIpAW function calculates the parallel form of the Proportional-Integral (Pl) controller with implemented integral

anti-windup functionality.

The PI controller attempts to correct the error between the measured process variable and the desired set-point by calculating a
corrective action that can adjust the process accordingly. The GFLIB_CtrIPIpAW function calculates the Pl algorithm according
to the equations below. The PI algorithm is implemented in the parallel (non-interacting) form, allowing the user to define the P
and | parameters independently and without interaction. The controller output is limited and the limit values (upper limit and lower

limit) are defined by the user.

The PI controller algorithm also returns a limitation flag, which indicates that the controller's output is at the limit. If the Pl controller
output reaches the upper or lower limit, then the limit flag is set to 1, otherwise it is 0 (integer values).

An anti-windup strategy is implemented by limiting the integral portion. The integral state is limited by the controller limits in the
same way as the controller output. The integration can be stopped by a flag that is pointed to by the function's API.

The PI algorithm in the continuous time domain can be expressed as follows:

ut)=et) K p+ K,je(t)dt

Figure 101.

where:
 u(t) is the controller output in the continuous time domain
+ e(t) is the input error in the continuous time domain
» Kp is the proportional gain
» K is the integral gain

Equation 1 can be expressed using the Laplace transformation as follows:
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Figure 102.

The proportional part (up) of Equation 1 is transformed into the discrete time domain as follows:

uplk) = K p- k)

Figure 103.

where:
» up(K) is the proportional action in the actual step
» e(k) is the error in the actual step
» Kp is the proportional gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

uPsc(k) Upmgxe = K P’ esc(k) “Cmax

Figure 104.

where:
* Umay is the action output scale
* upsc(K) is the scaled proportional action in the actual step
* emay is the error input scale
* e4c(K) is the scale error in the actual step

Transforming the integral part (u;) of Equation 1 into a discrete time domain using the bi-linear method, also known as the
trapezoidal approximation, is as follows:

KT, KT,
k) = gk = )+ (k) =52 + ek — =5

Figure 105.

where:
» u(k) is the integral action in the actual step
» ui(k - 1) is the integral action from the previous step
» e(k) is the error in the actual step
» e(k - 1) is the error in the previous step
» T is the sampling period of the system
» K is the integral gain coefficient

Equation 5 can be used in the fractional arithmetic as follows:

esa(k) + esc(k — 1)
=e—=t——e

u[sc(k)' Umax = u]sc(k = D than+ K Ts ‘max

Figure 106.

where:
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* Umayx is the action output scale

* ujsc(k) is the scaled integral action in the actual step

* uc(k - 1) is the scaled integral action from the previous step
* emax is the error input scale

* egc(K) is the scaled error in the actual step

* egc(k - 1) is the scaled error in the previous step

The output signal limitation is implemented in this controller. The actual output u(k) is bounded not to exceed the given limit values
UpperLimit and LowerLimit. This is due to either the bounded power of the actuator or due to the physical constraints of the plant.

U pperLimit u(k)> U pperLimit
u(k)={ LowerLimit u(k) < Lower Limit
u(k) else
Figure 107.

The bounds are described by a limitation element, as shown in Equation 7. When the bounds are exceeded, the nonlinear
saturation characteristic will take effect and influence the dynamic behavior. The described limitation is implemented on the
integral part accumulator (limitation during the calculation) and on the overall controller output. Therefore, if the limitation occurs,
the controller output is clipped to its bounds, and the wind-up occurrence of the accumulator portion is avoided by saturating the
actual sum.

For a proper use of this function, it is recommended to initialize the function data by the GFLIB_CtrIPIpAWInit functions, before
using the GFLIB_CtrIPIpAW function. You must call this function when you want the PI controller to be initialized.

2.25.1 Available versions

This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The parameters use
the accumulator types.

The available versions of the GFLIB_CtrIPIpAWInit function are shown in the following table:

Table 37. Init function versions

Function name Input Parameters Result Description

type type

GFLIB_CtrlPIpAWInit_F16 frac16_t | GFLIB_CTRL_PI_P_AW_T_A32* |void The inputs are a 16-bit fractional
initial value and a pointer to the
controller's parameters structure.

The available versions of the GFLIB_CtrIPIpAW function are shown in the following table:

Table 38. Function versions

Function name Input type Parameters Result type

Error Stop flag

GFLIB_CtrIPIpAW_F16 | frac16_t bool_t * GFLIB_CTRL_PI_P_AW_T_A32* frac16_t

The error input is a 16-bit fractional value within the range <-1 ; 1). The integration of the PI
controller is suspended if the stop flag is set. When it is cleared, the integration continues. The
parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the
range <f16LowerLim ; f16UpperLim>.
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2.25.2 GFLIB_CTRL_PI_P_AW_T_A32

Variable name Input Description
type
a32PGain acc32_t | Proportional gain is set up according to Equation 4 as follows:
K
The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.
a32IGain acc32_t |Integral gain is set up according to Equation 6 as follows:
K Ty
The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.
f321AccK_1 frac32_t | State variable of the internal accumulator (integrator). Controlled by the algorithm.
f16InErrkK_1 frac16_t | Input error at the step k - 1. Controlled by the algorithm.
f16UpperLim frac16_t | Upper limit of the controller's output and the internal accumulator (integrator). This parameter
must be greater than f16LowerLim. Set by the user.
f16LowerLim frac16_t | Lower limit of the controller's output and the internal accumulator (integrator). This parameter
must be lower than f16UpperLim. Set by the user.
bLimFlag bool_t Limitation flag, which identifies that the controller's output reached the limits. 1 - the limit is

reached; 0 - the output is within the limits. Controlled by the application.

2.25.3 Declaration
The available GFLIB_CtrIPIpAWInit functions have the following declarations:

void GFLIB CtrlPIpAWInit F16 (fracl6_t f16InitVal, GFLIB CTRL PI P AW T A32 *psParam)

The available GFLIB_CtrIPIpAW functions have the following declarations:

fracl6_t GFLIB CtrlPIpAW Fl6(fraclée t flé6InErr, const bool t *pbStopIntegFlag,
GFLIB CTRL_PI P AW T A32 *psParam)

2.25.4 Function use
The use of the GFLIB_CtrIPIpAWInit and GFLIB_CtrlPIpAW functions is shown in the following examples:

Fixed-point version:
#include "gflib.h"

static fracl6é t fl6Result, fl6InitVal, flé6InErr;
static bool t bStoplIntegFlag;
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static GFLIB CTRL PI P AW T A32 sParam;
void Isr (void);

void main (void)

{
fl6InErr = FRAC16(-0.4);
sParam.a32PGain = ACC32(0.1);
sParam.a32IGain = ACC32(0.2);
sParam. fl6UpperLim = FRAC16(0.9);
sParam.fl6LowerLim = FRAC1l6(-0.9);
bStopIntegFlag = FALSE;

flé6Initval = FRAC16(0.0);

GFLIB CtrlPIpAWInit F16(fl6InitVal, &sParam);
/* periodically called function */
void Isr ()

{
fl6Result = GFLIB CtrlPIpAW F16(fl6InErr, &bStopIntegFlag, &sParam);

2.26 GFLIB_CtrIPIDpAW

The GFLIB_CtrlIPIDpAW function calculates the parallel form of the Proportional-Integral-Derivative (PID) controller with
implemented integral anti-windup functionality.

The PID controller attempts to correct the error between the measured process variable and the desired set-point by calculating a
corrective action that can adjust the process accordingly. The GFLIB_CtrIPIDpAW function calculates the PID algorithm according
to the equations below. The PID algorithm is implemented in the parallel (non-interacting) form, allowing the user to define the P,
I, and D parameters independently and without interaction. The controller output is limited, and the limit values (upper limit and
lower limit) are defined by the user.

The algorithm has two error inputs: one for the P and | calculation, and the other for the D calculation. This allows the user to apply
different filters on both inputs.

The PID controller algorithm also returns a limitation flag, which indicates that the controller's output is at the limit. If the PID
controller output reaches the upper or lower limit, then the limit flag is set to 1, otherwise it is 0 (integer values).

An anti-windup strategy is implemented by limiting the integral portion. The integral state is limited by the controller limits in the
same way as the controller output. The integration can be stopped by a flag, which is pointed to by the function's API.

The PID algorithm in the continuous time domain can be expressed as follows:

ut)=e(t) Kp+K del)dt +K D%e 20

Figure 108.

where
* u(t) is the controller output in the continuous time domain
« e(t) is the input error for the proportional and integral calculation in the continuous time domain
» ep(t) is the input error for the derivative calculation in the continuous time domain

» Kp is the proportional gain

GFLIB User's Guide, Rev. 5, 01 November 2021
User Guide 87 /106




NXP Semiconductors

Algorithms in detail

» K is the integral gain
* Kp is the derivative gain

Equation 1 can be expressed using the Laplace transformation as follows:

K
H(s):@:KP-FTI-FKd-s

Figure 109.

The proportional part (up) of Equation 1 is transformed into the discrete time domain as follows:

up(k)= K p-e(k)
Figure 110.

where:
» up(Kk) is the proportional action in the actual step
» e(k) is the error in the actual step
» Kp is the proportional gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

u Psc(k) Upmgx = K P esc(k) *Cmax

Figure 111.

where:
* Umax is the action output scale
* upsc(K) is the scaled proportional action in the actual step
* emax is the error input scale
* egc(K) is the scale error in the actual step

Transforming the integral part (u;) of Equation 1 into a discrete time domain using the bi-linear method, also known as the
trapezoidal approximation, is as follows:

KT,
uf(k)=uk — 1)+ e(k)- 5

KT,
+elk— =5

Figure 112.

where:
* uy(k) is the integral action in the actual step
» ui(k - 1) is the integral action from the previous step
+ e(k) is the error in the actual step
* e(k - 1) is the error in the previous step
* Tgis the sampling period of the system
» K is the integral gain coefficient

Equation 5 can be used in the fractional arithmetic as follows:
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esdk) +egdk — 1)
AN D

ulsc(k)' Umax = Mjsc(k - 1) Upax T K[ T max

Figure 113.

where:
* Umay is the action output scale
* Uisc(K) is the scaled integral action in the actual step
* Uc(k - 1) is the scaled integral action from the previous step
* emax is the error input scale
* egc(K) is the scaled error in the actual step
* egc(k - 1) is the scaled error in the previous step

The derivative part (up) of Equation 1 is transformed into the discrete time domain as follows:

Kp
up(k) =7 lepk)-ep(k-]

Figure 114.

where:
» up(k) is the proportional action in the actual step
» ep(k) is the error used for the derivative input in the actual step
» ep(k - 1) is the error used for the derivative input in the previous step
» Kp is the proportional gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

Kp
uDsc(k) Umax = TS : [eDsc(k) - eDsc(k - 1)] *Cmax

Figure 115.

where:
* Umay is the action output scale
* Upsc(k) is the scaled derivative action in the actual step
* emay is the error input scale
* epsc(k) is the scaled error for the derivative input in the actual step
* epsclk - 1) is the scaled error for the derivative input in the previous step

The output signal limitation is implemented in this controller. The actual output u(k) is bounded to not exceed the given limit values
- UpperLimit and LowerLimit. This is due to either the bounded power of the actuator, or due to the physical constraints of the plant.

U pperLimit u(k) > U pperLimit
u(k)={ LowerLimit u(k) < Lower Limit
u(k) else
Figure 116.

The bounds are described by a limitation element, as shown in Equation 7. When the bounds are exceeded, the non-linear
saturation characteristic will take effect, and influence the dynamic behavior. The described limitation is implemented in the
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integral part accumulator (limitation during the calculation) and in the overall controller output. Therefore, if the limitation occurs,
the controller output is clipped to its bounds, and the wind-up occurrence of the accumulator portion is avoided by saturating the
actual sum.

For a proper use of this function, it is recommended to initialize the function data by the GFLIB_CtrIPIDpAWInit functions, before
using the GFLIB_CtrIPIDpAW function. You must call this function, when you want the PID controller to be initialized.

2.26.1 Available versions

This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1). The parameters use
the accumulator types.

The available versions of the GFLIB_CtrIPIDpAWInit function are shown in the following table:

Table 39. Init function versions

Function name Input Parameters Result Description
type type
GFLIB_CtrIPIDpAWInit_F16 |frac16_t | GFLIB_CTRL_PID_P_AW_T_A32* |void The inputs are a 16-bit fractional

initial value and a pointer to the
controller's parameters structure.

The available versions of the GFLIB_CtrIPIDpAW function are shown in the following table:

Table 40. Function versions

Function name Input type Parameters Result
type

Plerror | Derror | Stopflag

GFLIB_CtrIPIDpAW_F16  |frac16_t |frac16_t |bool_t* |GFLIB_CTRL_PID_P_AW_T_A32* frac16_t

The error inputs are 16-bit fractional values within the range <-1 ; 1). The integration of the PID
controller is suspended if the stop flag is set. When it is cleared, the integration continues. The
parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the
range <f16LowerLim ; f16UpperLim>.

2.26.2 GFLIB_CTRL_PID_P_AW_T_A32

Variable name Input Description
type
a32PGain acc32_t | Proportional gain is set up according to Equation 4 as follows:
Kprie

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.

a32lGain acc32_t |Integral gain is set up according to Equation 6 as follows:

K[ T emax

S Umax

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.

a32DGain acc32_t | Derivative gain is set up according to Equation 6 as follows:

Table continues on the next page...
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Table continued from the previous page...

Variable name Input Description
type
Kp emar
7; Umax
The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user.
f321AccK_1 frac32_t | State variable of the internal accumulator (integrator). Controlled by the algorithm.
f16InErrK_1 frac16_t | Input error in the step k - 1. Controlled by the algorithm.
f16UpperLim frac16_t | Upper limit of the controller's output and the internal accumulator (integrator). This parameter
must be greater than f16LowerLim. Set by the user.
f16LowerLim frac16_t | Lower limit of the controller's output and the internal accumulator (integrator). This parameter
must be lower than f16UpperLim. Set by the user.
f16InErrDK_1 frac16_t | Input error for the derivative calculation in the step k - 1. Controlled by the algorithm.
bLimFlag bool_t Limitation flag, which identifies that the controller's output reached the limits. 1 - the limit is

reached; O - the output is within the limits. Controlled by the application.

2.26.3 Declaration
The available GFLIB_CtrIPIDpAWInit functions have the following declarations:

void GFLIB CtrlPIDpAWInit F16(fraclé t fl6InitVal, GFLIB CTRL PID P AW T A32 *psParam)

The available GFLIB_CtrIPIDpAW functions have the following declarations:

fracl6é tGFLIB CtrlPIDpAW F16(fracl6 t flé6InErr, fracl6 t fl6InErrD, const bool t *pbStopIntegFlag,
GFLIB CTRL PID P AW T A32 *psParam)

2.26.4 Function use
The use of the GFLIB_CtrIPIDpAWInit and GFLIB_CtrIPIDpAW functions is shown in the following examples:

{

Fixed-point version:
#include "gflib.h"
static fracl6é t fl6Result, fl6InitVal, flé6InErr, f16InErrD;
static bool t bStopIntegFlag;
static GFLIB CTRL PID P AW T A32 sParam;
void Isr (void) ;
void main (void)

fl16InErr = FRAC16(-0.4);

f16InErr = £f16InErrD;
sParam.a32PGain = ACC32(0.1);
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sParam.
sParam.
sParam.
sParam.

a32IGain =
a32DbGain =

ACC32(0.2);
ACC32(0.001);

fl6UpperLim = FRAC16(0.9);
fl6LowerLim = FRAC16(-0.9);
bStopIntegFlag =

FALSE;

fl6Initval = FRAC16(0.0);

GFLIB CtrlPIDpAWInit F16(fl16InitVal, &sParam);

/* periodically called function */

void Isr ()

{

fl6Result = GFLIB CtrlPIDpAW F16(f16InErr, f16InErrD, &bStoplIntegFlag,

Algorithms in detail

&sParam) ;
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Appendix A
Library types

A.1 bool_t

The bool_t type is a logical 16-bit type. It is able to store the boolean variables with two states: TRUE (1) or FALSE (0). Its definition

is as follows:
typedef unsigned short bool t;

The following figure shows the way in which the data is stored by this type:

Table 41. Data storage

15 14 13 12 11 10 9 8 7 6 0
Value Unused Logi
cal
TRUE O lolo|o|o0o|O0O|O]|O]oO]|oO 1
0 0 0
FALSE 0 0 0 0 0 0 0 0 0 0 0
0 0 0

To store a logical value as bool_t, use the FALSE or TRUE macros.

A.2 uint8_t

The uint8_t type is an unsigned 8-bit integer type. It is able to store the variables within the range <0 ; 255>. Its definition is

as follows:
typedef unsigned char uint8_t;

The following figure shows the way in which the data is stored by this type:

Table 42. Data storage

Value Integer

255 1 1 1 1 1

Table continues on the next page...
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Library types
Table 42. Data storage (continued)
11 0 0 0 1 1
0
124 0 1 1 1 0
7
159 1 0 0 1 1
9
A.3 uint16_t

The uint16_t type is an unsigned 16-bit integer type. It is able to store the variables within the range <0 ; 65535>. Its definition is

as follows:

typedef unsigned short uintlé6 t;

The following figure shows the way in which the data is stored by this type:

Table 43. Data storage

15 14 13 12 1" 10 7 0
Value Integer

65535 1 1 1 1 1 1 1 1
F

5 0 0 0 0 0 0 0 1
0

15518 0 0 1 1 1 1 1 0
3

40768 1 0 0 1 1 1 0 0
9
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The uint32_t type is an unsigned 32-bit integer type. Itis able to store the variables within the range <0 ; 4294967295>. Its definition

is as follows:

typedef unsigned long uint32 t;

The following figure shows the way in which the data is stored by this type:

Table 44. Data storage

31 24 23 16 15 7 0
Value Integer
4294967295 F F F F
2147483648 8 0 0 0
55977296 0 3 2 0
3451051828 C D D 4
A.5 int8_t

The int8_t type is a signed 8-bit integer type. It is able to store the variables within the range <-128 ; 127>. Its definition is as follows:

typedef char int8 t;

The following figure shows the way in which the data is stored by this type:

Table 45. Data storage

Table continues on the next page...
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Value Sign Integer

127 0 1 1 1 1
7

-128 1 0 0 0 0
8

60 0 0 1 1 0
3
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Table 45. Data storage (continued)

-97 1 0 0 1 1 1 1 1

A.6 int16_t

The int16_t type is a signed 16-bit integer type. It is able to store the variables within the range <-32768 ; 32767>. Its definition is
as follows:

typedef short intl6 t;

The following figure shows the way in which the data is stored by this type:

Table 46. Data storage

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Value Sign Integer
32767 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
7 F F F
-32768 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
8 0 0 0
15518 0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0
3 Cc 9 E
-24768 1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0
9 F 4 0
A.7 int32_t

The int32_t type is a signed 32-bit integer type. It is able to store the variables within the range <-2147483648 ; 2147483647>. Its
definition is as follows:

typedef long int32 t;

The following figure shows the way in which the data is stored by this type:

Table 47. Data storage

Table continues on the next page...
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Table 47. Data storage (continued)
31 24 23 16 15 8 7 0
Value S Integer
2147483647 7 F F F F F F F
-2147483648 8 0 0 0 0 0 0 0
55977296 0 3 5 6 2 5 5 0
-843915468 C D B 2 D F 3 4
A.8 frac8_t

The frac8_t type is a signed 8-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:
typedef char frac8 t;

The following figure shows the way in which the data is stored by this type:

Table 48. Data storage

7 6 5 4 3 2 1 0
Value Sign Fractional
0.99219 0 1 1 1 1 1 1 1
7 F
-1.0 1 0 0 0 0 0 0 0
8 0
0.46875 0 0 1 1 1 1 0 0
3 C
-0.75781 1 0 0 1 1 1 1 1
9 F

To store a real number as frac8_t, use the FRAC8 macro.
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A.9 frac16_t

The frac16_t type is a signed 16-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is
as follows:

typedef short fraclé6 t;

The following figure shows the way in which the data is stored by this type:

Table 49. Data storage

%5 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Value Sign Fractional
0.99997 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
7 F F F
-1.0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
8 0 0 0
0.47357 0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0
3 Cc 9 E
-0.75586 1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0
9 F 4 0

To store a real number as frac16_t, use the FRAC16 macro.

A.10 frac32_t

The frac32_t type is a signed 32-bit fractional type. It is able to store the variables within the range <-1; 1). Its definition is
as follows:

typedef long frac32 t;

The following figure shows the way in which the data is stored by this type:

Table 50. Data storage

31 24 23 16 15 8 7 0

Value S Fractional

0.9999999995

~
M

F F F F F F

Table continues on the next page...
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Library types

-1.0 8 0 0 0 0
0.02606645970 0 3 5 6 2
-0.3929787632 Cc D B 2 D

To store a real number as frac32_t, use the FRAC32 macro.

A.11 acc16_t

The acc16_t type is a signed 16-bit fractional type. It is able to store the variables within the range <-256 ; 256). Its definition is

as follows:
typedef short accl6 t;

The following figure shows the way in which the data is stored by this type:

Table 51. Data storage

15 14 13 12 11 10 9 8 7 6 3
Value Sign Integer Fractional

255.9921875 0 1 1 1 1 1 1 1 1 1 1
7 F F

-256.0 1 0 0 0 0 0 0 0 0 0 0
8 0 0

1.0 0 0 0 0 0 0 0 0 1 0 0
0 0 8

-1.0 1 1 1 1 1 1 1 1 1 0 0
F F 8

13.7890625 0 0 0 0 0 1 1 0 1 1 0
0 6 E

-89.71875 1t /1]0|1|o0o|l0|1]1]|]0]o0O 0
D 3 2
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To store a real number as acc16_t, use the ACC16 macro.

A.12 acc32_t

The acc32_t type is a signed 32-bit accumulator type. It is able to store the variables within the range <-65536 ; 65536). Its
definition is as follows:

typedef long acc32 t;

The following figure shows the way in which the data is stored by this type:

Table 52. Data storage

31 24 23 16 15 8 7 0

Value S Integer Fractional
65535.999969 7 F F F F F F F
-65536.0 8 0 0 0 0 0 0 0
1.0 0 0 0 0 8 0 0 0
-1.0 F F F F 8 0 0 0
23.789734 0 0 0 B E 5 1 6
-1171.306793 F D B 6 5 8 B c

To store a real number as acc32_t, use the ACC32 macro.

A.13 float_t

The float_t type is a signed 32-bit single precision floating-point type, defined by IEEE 754. It is able to store the full precision
(normalized) finite variables within the range <-3.40282 - 1038 ; 3.40282 - 1038) with the minimum resolution of 2-23, The smallest
normalized number is £1.17549 - 10-38. Nevertheless, the denormalized numbers (with reduced precision) reach yet lower values,
from £1.40130 - 1045 to £1.17549 - 1038, The standard also defines the additional values:

* Negative zero
* Infinity
» Negative infinity
* Not a number
The 32-bit type is composed of:
« Sign (bit 31)
» Exponent (bits 23 to 30)
* Mantissa (bits 0 to 22)

The conversion of the number is straighforward. The sign of the number is stored in bit 31. The binary exponent is decoded as
an integer from bits 23 to 30 by subtracting 127. The mantissa (fraction) is stored in bits 0 to 22. An invisible leading bit (it is not
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actually stored) with value 1.0 is placed in front; therefore, bit 23 has a value of 0.5, bit 22 has a value 0.25, and so on. As a result,
the mantissa has a value between 1.0 and 2. If the exponent reaches -127 (binary 00000000), the leading 1.0 is no longer used
to enable the gradual underflow.

The float_t type definition is as follows:
typedef float float t;

The following figure shows the way in which the data is stored by this type:

Table 53. Data storage - normalized values

31 24 23 16 15 8 7 0

Value S Exponent Mantissa

(20-22%-227 /o1 1111110111111 11111111111111111

= 3.40282 - 1038 7 F 7 F F F F F

(20-22-2271111 111111011111 111111111111111111

=-3.40282 - 1038 F F 7 F F F F F

2126 0Oloooooo0oo0'0000000000D0O0DO0O0ODO0OO0OO0OO0GO 0O

= 1.17549 - 10-38 0 0 8 0 0 0 0 0

-2°126 Tooo0oo0000'"000000000000O0O0O0DO0OO0OO0GO0TO0DO

=-1.17549 - 10-38 8 0 8 0 0 0 0 0

1.0 0lo11111117000000000000000000O00O00O0O0O

-1.0 "o1111117000000000000000000O00O0O0GO0O

h oj/1o00000091001001000011111101101 1

= 3.1415927 4 0 4 9 0 F D B

-20810.086 |11 0 0 0110 1/01000101001010000101100

Cc 6 A 2 9 4 2 Cc

Table continues on the next page...
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Table 53. Data storage - normalized values (continued)
Table 54. Data storage - denormalized values
31 24 23 16 15 87 0
Value S Exponent Mantissa
0.0 0Oloo0o000090000000000000O0O0O0O0O0O00O0O0O0O
0 0 0 0 0 0 0 0
-0.0 "oooo00009%90000000000000O0DO0O0OOO0O0O0O0TO0OQO
8 0 0 0 0 0 0 0

(10-22%.2"%/glo 00 00000(11111111111111111111111

~1.17549 - 10'38 0 0 7 F F F F F

(1.0-22%.2726/110 00000091111 1111111111111111111

= -1.17549 - 1038 8 0 7 F F F F F

2. 2126 0Olooo000001000000000000000O0O0O0O0GO0O0O

= 5.87747 - 10739 0 0 4 0 0 0 0 0

2127126 "o 0000000100000 00000000O0DO0O0O0O0O0O0O0DO

= -5.87747 - 103 8 0 4 0 0 0 0 0

223 . p-126 Oloooo0oo0000/000000000DO0O0ODO0OOOO0OOOO0OGOTO0 1

= 1.40130 - 1045 0 0 0 0 0 0 0 1

-2-28. 2-126 "o o00000090000000000000O00O0O0OO0OGO0O0O0 1

= -1.40130 - 1045 8 0 0 0 0 0 0 1
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Table 55. Data storage - special values
31 24 23 16 15 0
Value S Exponent Mantissa
® 0 11111 17M000000000000000O0O0O0O0GO0GO0TO0O0
F 0 0 0 0
s 1 11111 17000000000000000000O0O0O0TO0O
F 0 0 0 0
Not a number | * 111111 non zero
7/F 800001 to FFFFFF

A.14 FALSE

The FALSE macro serves to write a correct value standing for the logical FALSE value of the bool_t type. Its definition is as follows:

#define FALSE ((bool t)0)

#include "mlib.h"
static bool t bval;

void main (void)
{

bVal = FALSE;
}

/* bvVal = FALSE */

A.15 TRUE

The TRUE macro serves to write a correct value standing for the logical TRUE value of the bool_t type. Its definition is as follows:

#define TRUE ((bool t)1)

#include "mlib.h"
static bool t bval;

void main (void)

{
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bval = TRUE; /* bval = TRUE */

A.16 FRACS
The FRACS8 macro serves to convert a real number to the frac8_t type. Its definition is as follows:
#define FRACS8 (x) ((frac8 t) ((x) < 0.9921875 2 ((x) >= -1 ? (x)*0x80 : 0x80) : O0x7F))

The input is multiplied by 128 (=27). The output is limited to the range <0x80 ; 0x7F>, which corresponds to <-1.0 ; 1.0-27>.

#include "mlib.h"
static frac8 t f8val;
void main (void)

{
f8val = FRAC8(0.187); /* f8val = 0.187 */

A.17 FRAC16
The FRAC16 macro serves to convert a real number to the frac16_t type. Its definition is as follows:
#define FRACL6(x) ((fracl6 t) ((x) < 0.999969482421875 ? ((x) >= -1 2 (x)*0x8000 : 0x8000) : O0x7FFF))

The input is multiplied by 32768 (=219). The output is limited to the range <0x8000 ; 0x7FFF>, which corresponds to
<-1.0; 1.0-21%>,

#include "mlib.h"
static fraclé t flé6vVal;
void main (void)

{
fléval = FRAC16(0.736); /* fleval = 0.736 */

A.18 FRAC32
The FRAC32 macro serves to convert a real number to the frac32_t type. Its definition is as follows:
#define FRAC32 (x) ((frac32 t) ((x) <1 ? ((x) > -1 ? (x)*0x80000000 : 0x80000000) : Ox7FFFFFFF))

The input is multiplied by 2147483648 (=23). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds
to <-1.0 ; 1.0-231>,

#include "mlib.h"
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static frac32 t f32val;
void main (void)

{
f32val = FRAC32(-0.1735667) ; /* £32val = -0.1735667 */

A.19 ACC16
The ACC16 macro serves to convert a real number to the acc16_t type. lts definition is as follows:
#define ACC16(x) ((accl6 t) ((x) < 255.9921875 ? ((x) >= -256 ? (x)*0x80 : 0x8000) : Ox7FFF))

The input is multiplied by 128 (=27). The output is limited to the range <0x8000 ; 0x7FFF> that corresponds to
<-256.0 ; 255.9921875>.

#include "mlib.h"
static accl6_t aléval;
void main (void)

{
aléval = ACC16(19.45627); /* aleVal = 19.45627 */

A.20 ACC32

The ACC32 macro serves to convert a real number to the acc32_t type. Its definition is as follows:

#define ACC32 (x) ((acc32 t) ((x) < 65535.999969482421875 ? ((x) >= -65536 ? (x)*0x8000 : 0x80000000)
O0x7FFFFFFF))

The input is multiplied by 32768 (=21%). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds to
<-65536.0 ; 65536.0-2715>,

#include "mlib.h"
static acc32 t a32val;
void main (void)

{
a32vVal = ACC32(-13.654437); /* a32val = -13.654437 */
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